Credits

Kidspiration® is designed, developed and marketed by Inspiration Software®, Inc.

Original Creators Don Helfgott and Mona Westhaver

Product Manager Megan Murphy

Systems Analyst Jack Bennet

Programming Manager Sid Snyder

Technical Lead John Shankland

Programmers Steve Bernard, Michael Fawver, Mark Fornia, Craig Kemper, John Shankland, Sid Snyder, Wyatt Webb

Quality Assurance Manager Shauna Gonzales

Quality Assurance Lead Ken Rueckert

Quality Assurance Staff Brad DeWitt, Ken Rueckert, Kim Russell

Other Testers Ted Assur, Loren Barr, Jim Clarke, Keith Miller, Adrian Quan, David Zuttermeister

Interface & Symbol Designers Glenn Green, Linnea Johnsson, Jonathan Maier, Thomas Webb

Activities & Examples Authors Mary Chase, Linnea Johnsson, Bob Madar

Help System Author Rebecca Rudd

Prior Contributors Michael Beale, John Cromett, Dave Goldman, Jason Stafford

© 2004 Inspiration Software, Inc. Inspiration®, Inspiration Software®, Kidspiration®, and SuperGrouper® are registered trademarks of Inspiration Software, Inc. The Kidspiration design mark is a trademark of Inspiration Software, Inc.

Portions Copyright © 1990-94 Halcyon Software. All rights reserved. The Sentry Spelling-Checker Engine Copyright © 1993-1998 Wintertree Software Inc. GIF-LZW is licensed under U.S. Patent No. 4,558,302 and foreign counter parts from Unisys.

Other brands and trademarks are the property of their respective owners.
Changing the view ........................................................................................................ 104

**Chapter 5: Working in Writing View** ............................................................... 105
Working with written ideas .................................................................................. 105
Changing the view .............................................................................................. 112

**Chapter 6: Changing the Appearance of Projects** ........................................... 113
Formatting text ..................................................................................................... 113
Formatting symbols and SuperGrouper shapes .................................................. 115
Formatting links .................................................................................................. 118
Formatting the page ............................................................................................ 119

**Chapter 7: Editing Text** .................................................................................. 123
Editing text in a symbol ....................................................................................... 123
Editing text in an idea .......................................................................................... 123
Copying and pasting text .................................................................................... 124
Checking your spelling ......................................................................................... 124
Editing the user dictionary .................................................................................. 125

**Chapter 8: Using Audio in Projects** .............................................................. 127
Choosing the voice the computer uses ............................................................... 127
Reading the text in the Kidspiration interface .................................................. 128
Listening to the text in a project ......................................................................... 128
Recording a sound or words ................................................................................. 128
Playing a recorded sound .................................................................................... 130
Erasing a recorded sound .................................................................................... 130

**Chapter 9: Printing** ....................................................................................... 131
Printing a project ................................................................................................ 131
Printing page numbers on a writing project ..................................................... 131
Printing your name at the top of the page ......................................................... 132
Selecting paper size ............................................................................................ 132
Setting page orientation ..................................................................................... 133
Scaling a project for printing................................................................. 133

Chapter 10: Teacher’s Reference ......................................................... 135
Enabling or disabling the Teacher menu ............................................. 135
Using the Kidspiration activities ........................................................ 136
Adding Internet hyperlinks to projects .............................................. 140
Changing the default look for projects .............................................. 142
Setting Application Options .............................................................. 143
Working with the symbol libraries .................................................... 147
Using Kidspiration projects with other programs ......................... 156
Publishing a project in a word processor ........................................ 157
Saving projects in other file formats .............................................. 159

Chapter 11: Accessibility ................................................................. 165
Accessibility for people with disabilities ............................................ 165
Using keyboard shortcuts............................................................... 165

Inspiration Software, Inc. License Agreement .................................... 171

Index .................................................................................................... 173
Chapter 1: Getting Started

Kidspiration® is the visual way for young learners to think, write and comprehend. Students create graphic organizers by combining pictures, text and spoken words. Working visually, young learners build important early literacy skills, while more advanced students are able to better understand information and communicate ideas.

Research shows that visual learning is one of the most effective means for teaching thinking skills. Kidspiration builds on these proven techniques, inspiring young students to improve comprehension, clarify thinking, increase retention and strengthen organization—creating a foundation for academic success.

Use Kidspiration in reading and writing, social studies, science and math … or anytime students need to visualize, organize or categorize information.

This guide is designed to help you get started using Kidspiration, quickly and easily. It contains:

- What’s new in Kidspiration 2
- System requirements
- Installation instructions
- Customer service information
- Tutorial
- Instructions for using Kidspiration commands and features
Where to find more information

- The Kidspiration Help system contains detailed information about using Kidspiration commands and features. To access Help while you are using Kidspiration, click Kidspiration Help on the Help menu.
- The Kidspiration User’s Guide contains a tutorial for new users and all the information in the Help system. The User’s Guide is available as a PDF document in the Documentation folder inside the Kidspiration 2 folder. To access the User’s Guide while you are using Kidspiration, click Kidspiration Documentation on the Help menu.
- Kidspiration Technical Support is available online. To connect to Technical Support while you are using Kidspiration, on the Teacher menu, point to Kidspiration Online, and then click Technical Support.

What’s new in Kidspiration 2!

Kidspiration includes the following improvements and new features:

**Draw**

**Symbol Maker tool.** To support emerging readers, Kidspiration 2 introduces the powerful Symbol Maker drawing tool. Students use familiar paint tools to easily create their own symbols. Drawings become an important element of their graphic organizers, allowing young learners to refine and personalize meaning.

**Group**

**Unlimited SuperGrouper® shapes.** Now, with just one click, teachers or students can transform any symbol into a SuperGrouper® shape. For example, students might place items for “school” into a backpack, rather than a plain circle or box. As a result, the activity becomes more engaging and meaningful.
**Venn diagram SuperGrouper shape.** A new Venn diagram shape enables students to use this classic technique to show understanding of similarities and differences.

**Connect**

**Picture feedback in Writing View.** Kidspiration 2 displays symbols in Writing View to reinforce the relationship between words and their meanings. And, as always, emerging readers and writers can use the Listen tool to hear their work read aloud. Research shows this combination of pictures, writing and spoken words improves young learners’ retention and comprehension.

**And more …**

**Features for teachers**

**75 standards-based activities.** Engaging activities offer opportunities for learning across the curriculum, including math! Easily modified, activities can be adapted to meet the demands of any curriculum.

**Share activities over a network.** Activities can be saved and launched from any location, making it a snap for classrooms to use customized lessons. Flexible access enables educators to collaborate and create new projects to build an exciting portfolio of curriculum-aligned lessons.

**Lock items in place.** Educators can now freeze the position of items in Picture or Writing View to ensure that young students do not accidentally move or delete symbols or SuperGrouper shapes that are core to a teacher-prepared activity.

**Limit symbol libraries.** The Activity Wizard permits teachers to limit the number of symbol libraries available for a specific project, removing distractions and focusing learning time.
Show or hide symbol captions. To add flexibility to lessons, Picture View symbol captions can be easily toggled on and off. A first click hides all symbol captions, while the second click labels all captioned symbols.

Teacher symbols for Picture View instructions. Kidspiration 2 allows educators to add Teacher symbols that appear only in Picture View. This new Teacher menu command eliminates the transfer of irrelevant information to Writing View.

Align and evenly space items. Now educators can effortlessly align and evenly space symbols and SuperGrouper shapes to fine-tune activities.

Password-protected Teacher menu. A password on the Teacher menu prevents students from changing teacher preferences.

Fast font selection. Fonts and text sizes are accessed via a pop-up menu, enabling users to quickly select their desired style.

Accessibility for all learners. A full range of keyboard shortcuts and other accessibility options empowers all learners to see, organize and develop their great ideas.

Kidspiration and Inspiration® compatibility. Educators and students can access and share any document created in Kidspiration 1 or Inspiration. Kidspiration 2 documents can also be saved as version 1, allowing projects to be opened and manipulated in the earlier version.
**Student-friendly enhancements**

**One-click publishing.** The Publish tool makes it a snap for students to finalize their Kidspiration writing projects in a word processor. With one click, this powerful tool launches AppleWorks® or Microsoft® Word and transfers student work from Kidspiration. Educators can modify settings to best fit the purpose of activities, allowing topics, notes and even a picture of the diagram to appear in the final draft.

**Intuitively delete symbols.** Kidspiration 2 works the way kids do! When students drag a symbol back to the palette, it’s deleted—just as they expected.

**See student name on screen.** Student names are now visible on screen so teachers can quickly see if students entered their identifying information.

**Student name is file name.** To simplify file saving and better utilize valuable learning time, text entered into the Student Name dialog becomes the suggested file name when students save a project.

**Fit entire picture onto screen.** A new view option sizes an entire Picture View project perfectly on screen.

**Quick scroll symbol libraries.** Descriptive library names make locating the perfect image a fast and easy task. Plus, instant feedback permits students to see each library as they scroll through the list.

**Easily reverse a link.** Using the Arrow tool on the Formatting toolbar, students can freely reverse links and change the structure of the items in Writing View.
Installing Kidspiration

Kidspiration requires certain hardware and software components to run. Before installing make sure your computer meets the following minimum requirements:

System requirements

Macintosh

- Macintosh or Power Macintosh
- System 7.1, 8.x, 9.x or OS X
- 4 MB available RAM
- 640 x 480, 256 color display
- 7 MB available hard disk space; 35 MB for full install
- CD-ROM drive (for installation only)
- Optional:
  - Macintosh compatible printer
  - Internet browser
  - Microphone
Windows

- Pentium 75 MHz or faster
- Windows 95, 98, 2000, NT 4.0, ME or XP
- 5 MB of available hard disk space; 20 MB for full install
- 8 MB of RAM
- 640 x 480, 256 color display
- CD-ROM drive (for installation only)
- Optional:
  - Windows compatible printer
  - Internet browser
  - Soundcard and speakers
  - Microphone

About upgrading from an earlier version of Kidspiration

When you install Kidspiration 2, it does not overwrite any earlier version of Kidspiration installed on your computer. This enables you to keep custom activities and custom symbol libraries created in the earlier version of Kidspiration.

After you install Kidspiration 2, you can copy custom activities and symbol libraries from the earlier version of Kidspiration to the Kidspiration 2 folder.

Copy symbol libraries from the earlier version of Kidspiration to a folder inside the Kidspiration Libraries folder. You can copy the libraries to an existing folder or to a folder you create. For example, you could create a new folder called “Kidspiration 1 Symbols.”

Copy activities from the earlier version of Kidspiration to the Kidspiration Activities folder inside the Kidspiration 2 folder. After you copy the activities and libraries you want to keep, you can remove the earlier version of Kidspiration.

Any files you created using Kidspiration 1 can be opened by Kidspiration 2.
Macintosh installation

1. Close all programs including screen saver and anti-virus programs.

2. Insert the Kidspiration CD-ROM into your CD-ROM drive.

3. Double-click the icon for your CD-ROM drive, and then double-click the **Kidspiration Install** icon to install Kidspiration. If you are using OS X, double-click **Kidspiration 2 Install OS X**.
   If necessary, the installer will ask to add the required text-to-speech software to your computer. Click **OK** to install. After updating the computer’s system software, your computer will restart and automatically continue the Kidspiration installation.

4. On the drop-down menu, select **Easy Install** or **Custom Install**:
   • Select **Easy Install** to install the full Kidspiration program, including symbols, activities, examples and the Help system.
     –or–
   • Select **Custom Install** to selectively install Kidspiration program components. Select this option if you have limited hard disk space and you do not want to install the full Kidspiration program.

5. Follow the instructions on your screen to complete the installation process. A message appears when installation is complete.

6. Kidspiration starts automatically and the Personalize Kidspiration dialog appears.
   Enter your name and/or organization and your serial number.

   **Note:** Your serial number can be found on the CD-ROM sleeve. The serial number identifies your copy of Kidspiration; it is required to personalize your Kidspiration application. Click **OK**.

   To register your copy of Kidspiration, see “Registering Kidspiration” on page 10.
Windows installation

1. Close all programs including screen saver and anti-virus programs.

2. Insert the Kidspiration CD-ROM into your CD-ROM drive.

3. Click the Install button to install Kidspiration.
   If necessary, the installer will ask to add the required text-to-speech software to your computer. Click OK to install. After updating the computer's system software, your computer will restart and automatically continue the Kidspiration installation.

4. Select Easy Install or Custom Install:
   - Select Easy Install to install the full Kidspiration program, including symbols, activities, examples and the Help system.
   - or -
   - Select Custom Install to selectively install Kidspiration program components. Select this option if you have limited hard disk space and you do not want to install the full Kidspiration program.

5. Follow the instructions on your screen to complete the installation process. A message appears when installation is complete.

6. Kidspiration starts automatically and the Personalize Kidspiration dialog appears.
   Enter your name and/or organization and your serial number.

   Note: Your serial number can be found on the CD-ROM sleeve. The serial number identifies your copy of Kidspiration; it is required to personalize your Kidspiration application. Click OK.

   To register your copy of Kidspiration, see “Registering Kidspiration” on page 10.
**Network installation**

Refer to the network installation instructions provided with your volume license. Volume licenses are available from Inspiration Software®, Inc. For more information, call 503-297-3004.

**Registering Kidspiration**

If you purchased a single copy of Kidspiration, you can register online or send in the printed registration card provided.

To register online, click **Register Online** after you personalize Kidspiration. Your browser starts and opens Kidspiration’s online registration form. Follow the on-screen instructions. *(Note: You must have a modem and a browser installed to register online.)* If you are unable to register online, please complete and mail the printed registration form.

To register a volume license, please complete and mail or fax the printed license agreement.

When you register, you’re entitled to special benefits from Inspiration Software, Inc. As a registered customer, you receive:

- Free telephone, fax and email technical support
- Substantial discounts on Kidspiration upgrades
- Tips on using Kidspiration
- Information about new products and product updates
- Flashes, the Inspiration Software, Inc. newsletter
About Kidspiration customer service

Inspiration Software®, Inc. is committed to assisting our customers. If you have comments, questions or need assistance while working with Kidspiration, please contact us by email, telephone or fax. You can also connect to Kidspiration Technical Support while you are using Kidspiration. On the Teacher menu, point to Kidspiration Online, and then click Technical Support.

Inspiration Software, Inc. provides free customer service and technical support for registered users. Be sure to register so you can take advantage of our support services.

When you contact us, please be prepared to provide your serial number. Our support services are open Monday through Friday from 7 a.m. to 5 p.m. Pacific Time.

Telephone  503-297-3004  
            Monday–Friday

Fax  503-297-4676

Email  techsupport@inspiration.com
Viewing and printing Kidspiration documentation

The Kidspiration User's Guide and other written documentation is available in the form of PDF files. To view or print this information, you need Adobe® Reader® installed on your computer. If your computer does not have Adobe Reader, you can download a free copy from Adobe at www.adobe.com.

To view or print Kidspiration documentation on a Macintosh:

1. Double-click the Kidspiration 2 folder on your hard drive.
2. Double-click the Kidspiration Documentation folder to open it. The folder contains three PDFs:
   - Symbol Guide.pdf: Illustrated listing of all built-in symbol libraries
   - Activity Guide.pdf: Overview of built-in activities with instructions and standards match
3. Double-click a PDF to view or print it.

To view or print Kidspiration documentation in Windows:

1. On the desktop, double-click My Computer.
2. In My Computer, double-click the icon for the drive where Kidspiration is installed.
3. Double-click the Kidspiration 2 folder to open it.
4. Double-click the **Kidspiration Documentation** folder to open it. The folder contains three PDFs:

- **User’s Guide.pdf** — *User’s Guide*, including installation instructions and tutorial
- **Symbol Guide.pdf** — Illustrated listing of all built-in symbol libraries
- **Activity Guide.pdf** — Overview of built-in activities with instructions and standards match

5. Double-click a PDF to view or print it.

**Removing Kidspiration**

**Macintosh**

- Drag the **Kidspiration 2** folder to the **Trash**, and then empty the **Trash**.

**Windows**

1. Click the **Start** button, point to **Settings**, and then click **Control Panel**.
2. Double-click **Add/Remove Programs**.
3. Click **Kidspiration 2** in the list box, and then click **Add/Remove**.

---

Kidspiration® User’s Guide  13
Chapter 2: Kidspiration Basics

Starting and closing Kidspiration

To start Kidspiration:

- Open the Kidspiration 2 folder, and then double-click the Kidspiration 2 icon (Macintosh).

- or -

- Click the Start button, point to Programs, and then click Kidspiration 2 (Windows).

To close Kidspiration:

- On the File menu, click Quit (Macintosh) or Exit (Windows).

Starting a new Kidspiration project

1. Start Kidspiration.

- or -

To return to the Kidspiration Starter from an open project, click Linky, the Kidspiration character.
2. Do one of the following:
   • To start with a diagram, click the **Picture** button.
     ![](image1.png)
   • To start with words, click the **Writing** button.
     ![](image2.png)

**Opening an activity**

1. Start Kidspiration.
   –or–
   On the **File** menu, click **New** to return to the Kidspiration Starter.

2. Under **Activities**, click a category, for example “Science.”

3. Click the activity you want to open, and then click **OK**.

   **Note:** You cannot open a Kidspiration 2 activity using an earlier version of Kidspiration. To use a Kidspiration 2 activity with an earlier version of Kidspiration, first open the activity in Kidspiration 2, and save it in Kidspiration 1 format.

   **See Also**
   “Saving a project in Kidspiration 1 format” on page 160.
Opening an existing project

1. On the File menu, click Open.
   –or–
   From the Kidspiration Starter, click the Open File button.

2. Open the folder where the file is located.
3. In the list box, click the file you want to open, and then click OK.

See Also
“Opening a document created in another program” on page 156.

Adding your name to a project

You can add a student name to a project. The name is displayed in the following locations:

- In the title bar of the document.
- As the suggested file name when the project is saved the first time. (You can change the suggested name if you want.)
- At the top of every page when you print.

To add your name to a project:

1. Click the Student Name button.

2. Type the name in the box where indicated.
3. To choose where you want the name to appear on the page, select Left, Center or Right.
A preview of how the name will appear on the page is displayed in the box on the right side of the dialog box.

4. Click OK.

**Saving a project**

You should save your work frequently to prevent losing any changes if the computer quits unexpectedly.

**To save a project:**

1. On the **File** menu, click **Save** to save the latest changes to your work.
   
The first time you save, select the folder where you want to save the project and type a name for the project.

   If you have entered a student name for the project using the Student Name tool, the student name is the suggested file name. You can change the suggested name if you want.

2. In the Save dialog box, click **Save**.
   
   Each time you save a project, you are prompted to replace the existing file. Click **Replace** to save the project.

**Saving a project under a different name**

1. On the **File** menu, click **Save**.

2. Select the folder where you want to save the project.

3. Type a new name for the project, and then click **Save**.

**About Picture View**

In Picture View, Kidspiration gives you many different tools to map, organize and display ideas visually.

The buttons on the **Picture toolbar** provide easy access to the key features of the program. Point at a button on the toolbar to see and hear a brief description of the button’s purpose. Click a button to carry out the function.
The **Symbol palette** includes hundreds of symbols you can use to show your ideas visually. Point at a symbol to see a magnified preview. To place a symbol on your diagram, drag the symbol from the Symbol palette.

The **Main Idea** symbol provides a starting point for your diagram. Type text in the Main Idea symbol or change it to a symbol that represents your idea.

Use the tools on the **Formatting toolbar** to change the look of the text, symbols and links on your diagram.

To return to the Kidspiration Starter at any time, click **Linky**, the Kidspiration character. You will be prompted to save the open project.
### Toolbar buttons in Picture View

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Go to Writing" /></td>
<td>Go to Writing View.</td>
</tr>
<tr>
<td><img src="image" alt="Add Symbol" /></td>
<td>Add a linked or unconnected symbol to your diagram.</td>
</tr>
<tr>
<td><img src="image" alt="Link Symbols" /></td>
<td>Link symbols on your diagram.</td>
</tr>
<tr>
<td><img src="image" alt="SuperGrouper" /></td>
<td>Add, create or change a SuperGrouper shape.</td>
</tr>
<tr>
<td><img src="image" alt="Clear" /></td>
<td>Clear the current selection (symbol, link, SuperGrouper shape or text) from your diagram.</td>
</tr>
<tr>
<td><img src="image" alt="Undo" /></td>
<td>Undo the last change you made.</td>
</tr>
<tr>
<td><img src="image" alt="Listen" /></td>
<td>Turn on the Listen tool. Click a symbol, link or SuperGrouper shape to hear the computer read the text in the selection.</td>
</tr>
<tr>
<td><img src="image" alt="Student Name" /></td>
<td>Add your name to a project. After you add your name, it appears in the title bar of the document. When you print, it appears at the top of every page.</td>
</tr>
<tr>
<td><img src="image" alt="Symbol Maker" /></td>
<td>Draw your own symbol using the Symbol Maker tool.</td>
</tr>
</tbody>
</table>
The Symbol palette

Kidspiration offers over 1,200 colorful, high-resolution symbols including several hundred photographic-quality images and animated symbols. The symbols are organized into categories and libraries.

To choose a symbol on the Symbol palette:

1. Click the Pick Library button, and then click the symbol library you want in the list.
   Point to a library in the list to see a preview of the library on the Symbol palette.

2. Click the Next Library buttons to move between the symbol libraries.

   Click to see the next library.
   Click to select a library.
   Click to see the previous library.

To see a preview of a symbol, point to it.
**Formatting toolbar in Picture View**

When you change the look of a symbol or link, the change applies not only to that symbol, but also to new symbols and links that you add from that point on. For example, if you select a basic symbol shape such as an oval or rectangle, and you change its colors to green and black, any basic symbols you add to your diagram will also be green and black.
New symbols and links are not affected by changes to selected text within symbols and links.

**Click this button ...**  **... to do this**

- ![Times](image)
  - Change the font of the selected text, symbol, SuperGrouper shape or link.

- ![14](image)
  - Change the text size of the selected text, symbol, SuperGrouper shape or link.

- ![Bold](image)
  - Apply bold formatting to the words in the selected text, symbol, SuperGrouper shape or link.

- ![Italic](image)
  - Apply italic formatting to the words in the selected text, symbol, SuperGrouper shape or link.

- ![Underline](image)
  - Underline the words in the selected text, symbol, SuperGrouper shape or link.

- ![Color](image)
  - Change the color of the words in the selected symbol, SuperGrouper shape or link.

- ![Arrowhead](image)
  - Change the arrowhead style for the selected link.

- ![Line Width](image)
  - Change the line width of the selected symbol, SuperGrouper shape or link.

- ![Hide](image)
  - Hide symbol captions.

- ![Show](image)
  - Show symbol captions.

- ![Color Palette](image)
  - Change the colors of the selected symbol. **Note:** The colors that appear on the Formatting toolbar are the colors in the selected symbol.
About Writing View

If you started your project in Picture View, your work is transferred when you switch views. In Writing View, Kidspiration gives you many different tools for organizing and expanding your ideas in writing.

The buttons on the **Writing toolbar** provide easy access to the key Kidspiration features. Point at a button on the toolbar to see and hear a brief description of the button’s purpose. Click a button to carry out the function.

If you are beginning a new project in Writing View, the **Main Idea** provides a starting point for your writing. Type an idea into the Main Idea and go from there.

Use the tools on the **Formatting toolbar** to change the look of the text and the page.

To return to the Kidspiration Starter at any time, click **Linky**, the Kidspiration character. You will be prompted to save the open project.
## Toolbar buttons in Writing View

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Go to Pictures" /></td>
<td>Go to Picture View. Add a new idea to your project. Move the selected idea down one level in the hierarchy. Move the selected idea up one level in the hierarchy. Clear the selected text or idea from your project. Undo the last change you made. Turn on the Listen tool. Click an idea to hear the computer read it. Add your name to a project. After you add your name, it appears in the title bar of the document. When you print, it appears at the top of every page. Transfer your writing project to a word processor.</td>
</tr>
</tbody>
</table>
**Formatting toolbar in Writing View**

When you change the look of an idea, the change applies to new ideas you add to your writing project. For example, if you select an idea, and change its text color to green, any ideas you add to your writing project will also have green text.

New ideas are not affected by changes to selected text within an idea.

<table>
<thead>
<tr>
<th>Click this button...</th>
<th>...to do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Font Change" /></td>
<td>Change the font of the selected text or idea.</td>
</tr>
<tr>
<td><img src="image" alt="Size Change" /></td>
<td>Change the text size of the selected text or idea.</td>
</tr>
<tr>
<td><img src="image" alt="Bold" /></td>
<td>Apply bold formatting to the words in the selected text or idea.</td>
</tr>
<tr>
<td><img src="image" alt="Italic" /></td>
<td>Apply italic formatting to the words in the selected text or idea.</td>
</tr>
<tr>
<td><img src="image" alt="Underline" /></td>
<td>Underline the words in the selected text or idea.</td>
</tr>
<tr>
<td><img src="image" alt="Color Change" /></td>
<td>Change the color of the words in the selected text or idea.</td>
</tr>
<tr>
<td><img src="image" alt="Prefix Style" /></td>
<td>Change the prefix style.</td>
</tr>
<tr>
<td><img src="image" alt="Lined Paper" /></td>
<td>Show or hide the lined paper.</td>
</tr>
</tbody>
</table>
Chapter 3: Learning
Kidspiration, A Tutorial

This section of the User’s Guide is a tutorial that introduces basic Kidspiration diagram and writing tools. The tutorial takes about 30 minutes from start to finish.

You use Kidspiration the same way as most Mac OS and Windows programs. For example, as you work, you use the mouse to drag objects and to select text. You also click and double-click, and enter information using the keyboard. If you are not familiar with doing these things, take a moment now and refer to the user's guide that came with your computer.

Conventions we used

When you are asked to enter specific text, the text you will type appears in bold. For example, All About Me. When referring to a symbol or name you already entered, it appears in italics, like All About Me.

How we organized the tutorial

In the Kidspiration tutorial, you follow a series of step-by-step instructions to create a simple visual representation of an idea called a diagram. You also work with your ideas in writing.

The tutorial is organized in mini-lessons. They are designed to be completed in order, but you do not have to do them all at one time. Each mini-lesson introduces you to several of the unique features in Kidspiration. When you finish the tutorial, you will be ready to create diagrams, writing projects and activities on your own.
Mini-Lesson One: Creating a diagram in Picture View

In this lesson you will create a diagram called “All About Me” using symbols, words and links. You will learn to do the following:

• Start Kidspiration
• Start a new diagram
• Add your name to a project
• Save your work
• Add symbols to a diagram
• Use the Symbol palette
• Show and hide symbol captions
• Draw a symbol using the Symbol Maker tool
• Move symbols
• Change the colors of symbols
• Connect symbols using links
• Remove part of the diagram
• Fix a mistake
• Change the look of text using font, text size and color
• Close a project and return to the Kidspiration Starter

Starting Kidspiration

Note: Before you can start the program, Kidspiration needs to be installed. If you have not installed Kidspiration on your computer yet, see “Installing Kidspiration” on page 6.
To start Kidspiration on a Macintosh:

- Open the Kidspiration 2 folder, and then double-click the Kidspiration icon.

The Kidspiration Starter opens.

To start Kidspiration in Windows:

- Click the Start button, point to Programs, and then click Kidspiration 2.

The Kidspiration Starter opens.

The Kidspiration Starter is the place where you start new projects, open existing projects, and use the many different Kidspiration activities. You will begin by starting a new diagram.

Starting a new diagram

1. To start a new diagram, click the Picture button.

A new document opens with a Main Idea symbol. The Main Idea symbol provides a starting point for your work.

2. In the Main Idea symbol, type All About Me.

To add text to a symbol, select the symbol, and then type.
Adding your name to a project

1. On the Picture toolbar, click the Student Name button.

   ![To add your name to a project, click the Student Name button.]

2. Type your name in the box where indicated.
   
   For the examples in this tutorial we will use the name “Glenna.”

3. To choose where you want the name to appear on the page, select Left, Center or Right.
   
   A preview of how the name will appear on the page is displayed in the box on the right side of the dialog box.

4. Click OK.
   
   The student name appears in the title bar of the document.

Saving your work

You should save your work often so you do not lose any changes if the computer quits unexpectedly. The first time you save, you type a name for the project.

1. On the File menu, click Save.

2. In the folder list, click the folder where you want to save the project.
3. Type a name for the project, and then click **Save**.  
Kidspiration suggests the name “Glenna” based on the student name, but you can use a different name.

**Adding symbols to your diagram**

There are many different ways to add symbols in Picture View. An easy way to add a linked symbol is the Add Symbol tool.

1. Click the *All About Me* symbol to select it.

   ![All About Me](image)

   To select a symbol, click it.

2. To add two symbols that are connected to the *All About Me* symbol, click the **Add Symbol** button two times.

   ![Add Symbol](image)

   To add a linked symbol to the selected symbol, click the Add Symbol button.

   Now your diagram looks like this.

   ![Diagram](image)

3. Select the left symbol, and then type the word **Home**.
4. Select the right symbol, and then type the word **School**.

   Now the diagram looks like this.

   ![Final Diagram](image)
Using the Symbol palette

Now you will use the Symbol palette to add more symbols to the diagram. The Symbol palette has hundreds of symbols that you can use to show your ideas. Here is the Symbol palette.

1. On the Symbol palette, drag the heart symbol onto the diagram, and then type 2 sisters.

2. Click the Next Library button one time. Drag your favorite pet symbol onto the diagram.
3. On the Symbol palette, click the Pick Library button.
4. Scroll down the list to School, and then click Classroom.
5. Drag the books symbol onto the diagram.
   Adjust the position of the symbol so the diagram looks like this.

Showing symbol captions
To add flexibility to lessons, you can show or hide the symbol captions.

- To hide the symbol captions, click the Hide Captions button on the Formatting toolbar.
To show the symbol captions, click the **Show Captions** button on the **Formatting** toolbar.

The captions appear below all the symbols in the diagram.

### Drawing a symbol using the Symbol Maker tool

The Kidspiration Symbol Maker enables you to create your own symbols using draw and paint tools. You can draw lines and shapes and fill the shapes with different colors. The Stamp tool is an easy way to add images, numbers and letters to your drawing.

### Opening the Symbol Maker

1. Select the *All About Me* symbol.
2. On the **Picture** toolbar, click the **Symbol Maker** button.

The Kidspiration Symbol Maker opens.

- Use the tools on the **Tool palette** to draw lines and shapes and edit the drawing.
- Use the **Nib palette** to define the shape and width of the line for the selected tool.
- Use the **Color palette** to choose a color for the selected tool.
- Draw on the **canvas** in the center of the dialog box.
Tips before you begin drawing

There are some special tools on the Tool palette you may find useful as you begin drawing.

- If you make a mistake and you want to undo what you just did, click the **Undo** tool.
- If you want to clear the canvas and start over, click the **Clear All** tool.
- If you want to erase part of the drawing, click the **Erase** tool, and then drag the pointer over the area you want to erase. You
can click a nib on the Nib palette to define the shape and width of the eraser.

Drawing the face, including eyes, nose and mouth
1. On the Tool palette, click the Paintbrush button.

2. On the canvas, drag the Paintbrush to draw a face that looks something like this.

Filling the face and shirt with color
1. On the Tool palette, click the Paint Bucket button.

2. On the Color palette, click a color for the face.
3. On the canvas, click inside the face.
4. On the Color palette, click a color for the shirt.
5. On the canvas, click inside the shirt.
Now the drawing looks something like this.

Adding hair to the top of the head
1. On the Tool palette, click the Spray Can button.

2. To increase the width of the Spray Can pattern, click a larger nib on the Nib palette.

3. On the Color palette, click a color for the hair.
4. On the canvas, drag the **Spray Can** to draw hair that looks something like this.

![Image of a cartoon character with hair drawn using a spray can]

**Adding glasses to the face using the Stamp tool**

1. On the **Tool palette**, click the **Stamp** tool.

2. On the **Stamp palette**, use the **Up** or **Down** arrow to locate the glasses. Click the glasses stamp.

3. On the **Color palette**, click a color for the glasses.

4. To change the size of the glasses, click one of the **Size** buttons.
5. Roll the pointer over the face to see a preview of the glasses.
6. Position the glasses where you want them on the face, and then click to add the glasses to the drawing.
   Now the drawing looks something like this.

   ![Drawing with glasses]

### Adding the drawing to your diagram

- To add the drawing to the diagram, click the **Done** button.
  The *All About Me* symbol is replaced with the symbol you created.
**Moving symbols**

- In Kidspiration you can always move symbols by dragging them. When you do, any links automatically adjust. Drag the *All About Me* symbol up so your diagram looks like the one below.

**Changing the look of symbols using color**

Color is great for customizing the look of symbols. You can change the colors of two-color symbols and multicolor symbols.

1. Select the *Home* symbol.

   The Symbol Colors tool appears on the Formatting toolbar.
2. On the **Symbol Colors** tool, click the **Fill Color** button, and then click a new color on the palette.

3. Now change the line color of the symbol. On the **Symbol Colors** tool, click the **Line Color** button, and then click a new color on the palette.

4. Next change the colors of the **All About Me** symbol. Select the **All About Me** symbol.
   
   The Symbol Colors tool appears on the Formatting toolbar.

5. On the Symbol Colors tool, click the shirt color, and then click a new color on the palette.

6. On the Symbol Colors tool, click the glasses color, and then click a new color on the palette.
Connecting symbols using links

Now it is time to add links. The Link tool is used to demonstrate comprehension and show relationships.

1. Select the Home symbol. This is the symbol where the link will start.
2. On the Picture toolbar, click the Link button.

The cursor now looks like this.

3. Click the 2 sisters symbol to complete the link.
4. Follow these steps to link the remaining symbols.
   Your diagram should look like this.
Removing part of the diagram

Here is a quick way to remove part of your diagram.

1. Select the books symbol.
2. On the Picture toolbar, click the Clear button.

Fixing a mistake

The Undo tool is a quick way to fix something you did not mean to do.

- To undo what you just did, click the Undo button.

The books symbol reappears on the diagram.

Changing the look of text

You can customize text using font, text size and color.

1. Select the All About Me symbol.
2. Click inside the symbol’s text area, and then select the word Me.
3. On the **Formatting** toolbar, click in the **Font** box, and then click a new font in the list.

4. On the **Formatting** toolbar, click the **Text Color** button, and then click a new color on the palette.

5. Press the Escape key to end text editing and select the symbol. Now the text looks like this.
Closing your project and returning to the Kidspiration Starter

Congratulations! You have completed Mini-Lesson One. Close this lesson and continue to Mini-Lesson Two.

• To close your project and return to the Kidspiration Starter, click Linky, the Kidspiration character.

When you return to the Kidspiration Starter, you are prompted to save the open project. Click Yes to save the project.

Each time you save a project, you are prompted to replace the existing file. Click Replace to save the project.
Mini-Lesson Two: Working with ideas in Writing View

In this lesson you will open the diagram you created in the previous lesson and work with it in Writing View. You will learn to do the following:

• Open a project
• Switch to Writing View
• Add ideas
• Change the level of ideas
• Change the order of ideas
• Add details to ideas
• Change the look of text
• Hide the lined paper
• Change the prefix style
• Add your name to your project
• Save your project
• Publish your project in a word processor

Opening a project

1. On the File menu, choose Open.
   –or–
   From the Kidspiration Starter, click the Open File button.

2. Open the folder where you saved the file from the previous lesson.

3. In the list box, click the file you saved from the previous lesson, and then click Open.
Switching to Writing View

While you have been working in Picture View, Kidspiration has been building a written project using the ideas in your diagram.

- To view your ideas in Writing View, click the Go to Writing button.

In Writing View, the ideas in your diagram are organized from top to bottom, with your main idea—All About Me—at the top. Each idea appears on its own piece of lined paper. Symbols at the beginning of each idea help emerging readers develop word-meaning skills.

<table>
<thead>
<tr>
<th>All About Me</th>
</tr>
</thead>
<tbody>
<tr>
<td>School</td>
</tr>
<tr>
<td>books</td>
</tr>
<tr>
<td>Home</td>
</tr>
<tr>
<td>dog</td>
</tr>
<tr>
<td>2 sisters</td>
</tr>
</tbody>
</table>
Adding an idea

You can add a new idea in Writing View as easily as you added a new symbol in Picture View.

1. On the Writing toolbar, click the Add Idea button.

2. Type the word Dad in the new idea.

This is what your project looks like now.
Changing the level of an idea

There are many ways to organize ideas in Writing View. The Move Left and Move Right buttons on the Writing toolbar change the level of an idea in the hierarchy.

- On the Picture toolbar, click the Move Right button two times.

To move an idea down a level in the hierarchy, click the Move Right button.

Now the outline looks like this.

- All About Me
  - School
  - books
  - Home
  - dog
  - 2 sisters
  - Dad
Changing the order of ideas

You can also change the order of ideas by dragging and dropping.

1. Select the *Home* idea.

2. Point to the left or top edge of the idea. When the **appears, drag the idea above the *School* idea.

   While you drag, the idea remains in the original position until you release the mouse button. You can see where the idea’s new location will be by watching the black line as you drag. When the line is at the level you want the idea to appear, release the mouse button.

---

Watch the black line as you drag. When the line is at the level where you want the idea to appear, release the mouse button.
Now the project looks like this.

Adding details to an idea

Notes are a great way to add more information about an idea. You can add as many lines of notes as you wish.

1. The notes area is below the top line of the idea. Click in the notes area of the All About Me idea, and then type by Glenna.

2. Type details in the notes area of each idea.
Changing the look of text

The tools on the Formatting toolbar are used to customize the look of text in ideas or notes.

1. Click in the notes area of the *All About Me* idea, and then select the words *by Glenna*.

   ![All About Me by Glenna](image)

   To format text, select the text, and then use the tools on the Formatting toolbar.

2. To apply bold formatting to the selected words, click **A** on the Formatting toolbar.

3. Select the *All About Me* idea.
   Now the text *by Glenna* is bold.

Hiding the lined paper

Turning off the lined paper gives a writing project the look of a more traditional outline.

- To turn off the lined paper, click the **Hide Lined Paper** button on the Formatting toolbar.
Now the project looks like this.

**All About Me**

by Glenna

---

**Home**

My house is blue.
We have a big garden.

**Dog**

Bingo is my dog.
She likes to chase sticks.

**2 sisters**

I have two little sisters.

**Dad**

My dad is a painter.

**School**

I like school.

---

books
Changing the prefix style

As students become more advanced, Kidspiration can be used as a full-fledged outliner with a range of prefix options.

- To change the prefix, click the Prefix button on the Formatting toolbar until you see the prefix that you want. Now the project looks something like this.

<table>
<thead>
<tr>
<th>I. All About Me</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>by Glenna</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>A. Home</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>My house is blue.</td>
<td></td>
</tr>
<tr>
<td>We have a big garden.</td>
<td></td>
</tr>
</tbody>
</table>

1. dog
   - Bingo is my dog
   - She likes to chase sticks.

2. 2 sisters
   - I have two little sisters.

3. Dad
   - My dad is a painter.

<table>
<thead>
<tr>
<th>B. School</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>I like school.</td>
<td></td>
</tr>
</tbody>
</table>

1. books

Saving your work

Remember to save your work!

1. On the File menu, click Save.
2. Click Save.

Each time you save a project, you are prompted to replace the existing file. Click Replace to save the project.
Publishing your work in a word processor

The Publish tool transfers a writing project to Microsoft Word or Appleworks where you can put the finishing touches on your composition.

1. On the Writing toolbar, click the Publish button.

To transfer a writing project to a word processor, click the Publish button.

2. If necessary, select Microsoft Word or Appleworks, and then click OK.

If your computer has only one of these word processing programs, Kidspiration automatically opens the available program.

The selected word processor opens with a new document containing the information in your Kidspiration project.

A graphic of the diagram in Picture View appears followed by the text, including topics and notes.

You can control how a document is published—for example you can transfer only the notes in a project—using the Publish Options on the Teacher menu.

3. On the File menu, click Close to close the word processing document.

4. When you are prompted to save the document, click Don’t Save (AppleWorks) or No (Microsoft Word).
**Closing your project and returning to the Kidspiration Starter**

Now, close this project and continue to Mini-Lesson Three.

- To close your project and return to the Kidspiration Starter, click **Linky**, the Kidspiration character.

  ![Linky](image)

  When you return to the Kidspiration Starter, you are prompted to save the open project. Click **Yes** to save the project.

  Each time you save a project, you are prompted to replace the existing file. Click **Replace** to save the project.
Mini-Lesson Three: Sorting ideas using the SuperGrouper tool

In Kidspiration there are two basic ways to organize ideas in Picture View: links and SuperGrouper categories. You have already seen how links work. Now you will take a look at the SuperGrouper tool.

Categorizing and sorting are important skills for K-5 students, and the SuperGrouper tool makes these activities easy and fun. In many cases, teachers will find it most effective to create the SuperGrouper categories as part of an activity and let students simply sort ideas into their respective categories.

In this lesson, you will learn to do the following:

• Start a new diagram
• Save your work
• Add a SuperGrouper category
• Create a new SuperGrouper shape
• Add a title to a SuperGrouper category
• Change the colors of a SuperGrouper category
• Remove symbols from a SuperGrouper category
• Add symbols to a SuperGrouper category
• View SuperGrouper categories in Writing View
• Close a project and return to the Kidspiration Starter

Starting a new diagram

If you have not started Kidspiration, do so now.

• In the Kidspiration Starter, click the Picture button.

To start a new diagram, click the Picture button.

A new diagram opens with the Main Idea symbol selected.
**Saving your work**

The first time you save, you type a name for your project.

1. On the **File** menu, click **Save**.
2. In the folder list, click the folder where you want to save the project.
3. Type **SuperGrouper Lesson** for the name of the project, and then click **Save**.

**Adding a SuperGrouper category**

There are several ways to add SuperGrouper categories to your project.

1. On the **Picture** toolbar, click the **SuperGrouper** button.
2. On the **SuperGrouper** menu, click the rectangle SuperGrouper shape to add it to your diagram.

   ![Diagram of SuperGrouper categories]

   To add a SuperGrouper category, click the SuperGrouper button ...

   ... and then click the SuperGrouper shape.
The new SuperGrouper category automatically contains any selected symbols—in this example, the *Main Idea* symbol on the diagram.

---

**Creating a new SuperGrouper shape**

Any symbol can be transformed into a SuperGrouper shape.

1. Click the *Previous Library* button two times to go to the *Groupers 1* library.
2. Drag the *basket* symbol onto the diagram and place it to the left of the rectangle.
3. On the **Picture** toolbar, click the **SuperGrouper** button, and then click **Create SuperGrouper**.

To create a SuperGrouper shape, select the symbol, and click the SuperGrouper button ... 

... and then click **Create SuperGrouper**.

The *basket* symbol becomes a SuperGrouper category with a title area at the top. The symbol handles become stars and the new SuperGrouper is larger.

If necessary, drag the SuperGrouper shapes to adjust their location. Now the diagram looks like this.
Adding a title to a SuperGrouper category

SuperGrouper labels appear at the top of each shape.

1. Select the *basket* SuperGrouper category, and then type *Fruits*.
2. Select the *rectangle* SuperGrouper category, and then type *Vegetables*.

Here is what the diagram looks like now.

Changing the colors of a SuperGrouper shape

SuperGrouper shapes are formatted in the same way as symbols.

1. Select the *Vegetables* SuperGrouper category.

The Symbol Colors tool appears on the Formatting toolbar.
2. On the **Symbol Colors** tool, click the **Fill Color** button, and then click a new color on the palette.

![Symbol Colors tool](image)

3. Select the *Fruits* SuperGrouper category.

4. Using the **Symbol Colors** tool on the **Formatting** toolbar, try changing the colors of the *Fruits* SuperGrouper category.

**Removing a symbol from a SuperGrouper category**

- To remove the *Main Idea* symbol from the *Vegetables* SuperGrouper category, select the *Main Idea* symbol, and then click the **Clear** button on the **Picture** toolbar.

![Clear button](image)

—or–

Drag the symbol to the **Symbol palette** to delete it.
Adding symbols to a SuperGrouper category

To add symbols to each SuperGrouper category you simply drag and drop them from the Symbol palette.

1. On the Symbol palette, click the Pick Library button ▼,
2. Scroll down the list to Food and Health, and then click Fruits and Veggies.
3. Drag several symbols to the Fruits SuperGrouper category.
4. Drag several symbols to the Vegetables SuperGrouper category.

Viewing SuperGrouper categories in Writing View

Switching to Writing View provides a visual and written list of the items in each SuperGrouper category.

- To switch to Writing View, click the Go to Writing button on the Picture toolbar.
This is what the SuperGrouper categories look like in Writing View.

The titles of the SuperGrouper categories assume a top-level position, and the symbols in each SuperGrouper category are supporting ideas. Any changes you make here will be reflected in Picture View.
Closing your project and returning to the Kidspiration Starter

Congratulations! You have completed Mini-Lesson Three of the Kidspiration tutorial. Close this project and continue to Mini-Lesson Four.

- To close your project and return to the Kidspiration Starter, click **Linky**, the Kidspiration character.

  ![Linky](image)

  When you return to the Kidspiration Starter, you are prompted to save the open project. Click **Yes** to save the project.

  Each time you save a project, you are prompted to replace the existing file. Click **Replace** to save the project.
Mini-Lesson Four: Creating activities using the Teacher menu

The Teacher menu provides controls for setting up and customizing activities. In this lesson, you will open a Kidspiration activity called “Five Facts,” add information to the diagram and then save it as a new activity. You will learn to do the following:

- Open an activity
- Enable the Teacher menu
- Add a password to the Teacher menu
- Add an Internet hyperlink
- Create a Teacher symbol
- Lock a symbol
- Listen to the ideas in a diagram
- Record words or narration
- Print your work
- Save a project as an activity using the Activity Wizard

Opening an activity

1. Start Kidspiration.
2. Under Activities, click the More button.

3. Select the Five Facts activity, and then click OK.
   The Five Facts activity opens as a new, untitled document.
Enabling the Teacher menu

When you enable the Teacher menu, you make the commands on the Teacher menu available.

- To enable the Teacher menu, click **Enable Teacher Menu** on the **Teacher** menu.
  
  When the Teacher menu is enabled, a check mark appears next to the command.

Adding a password to the Teacher menu

You can create a password for the Teacher menu to prevent students from changing your preferences.

1. On the **Teacher** menu, choose **Application Options**.
2. Select the **Password Enabled** check box.
3. Click the **Set Password** button.
   
   The Set Password dialog box appears.
4. In the **Enter Password** box, type the password you want to use.
5. In the **Confirm Password** box, type the password again, and then click **OK**.
   
   When you enable the Teacher menu, you will be prompted to enter your password.
   
   **Tip:** If you forget your password, you can always use the password “Kidspiration 2” to enable the Teacher menu.

Adding an Internet hyperlink

You can easily add Internet hyperlinks to ideas, notes, symbols and links. Hyperlinks can be added by simply typing the URL, for example “www.inspiration.com.” Or, you can also assign a hyperlink to selected text.
1. Click in the upper left corner of the diagram.
The crosshair shows you where the new symbol will appear.

2. On the Symbol palette, click the thinking bubble symbol to add it to the diagram, and then type **Learn more about elephants on the Internet**.

3. Select the text *Learn more about elephants on the Internet*.

4. On the Teacher menu, click **URL Hyperlink**.
The text *Learn more about elephants on the Internet* appears in the **Hyperlink Text** box.

5. In the **Hyperlink Address** box, type `www.worldwildlife.org/species`, and then click **OK**.
The text *Learn more about elephants on the Internet* is now formatted as a hyperlink.

You can click the link to start your browser and go to the web site.
Creating a Teacher symbol

You can format a symbol so it appears only in Picture View. This feature is useful for instructions or symbols that are not relevant in Writing View.

1. Select the *Learn more about elephants on the Internet* symbol.
2. On the Teacher menu, click Teacher Symbol.
   The handles on a Teacher Symbol are red triangles.
3. On the Picture toolbar, click the Go to Writing button.
   The *Learn more about elephants on the Internet* symbol does not appear in Writing View.
   
   *Note:* The *Use pictures and words to tell five facts about a topic* symbol was already a Teacher symbol so it does not appear in Writing View either.

4. On the Writing toolbar, click the Go to Pictures button to return to Picture View.

Locking the position of a symbol

To add additional control to an activity, you can lock the position of a symbol or SuperGrouper shape to ensure that students do not accidentally move or delete it. When a symbol is locked, you can still format the symbol and edit the text.

1. Select the *Use pictures and words to tell five facts about a topic* symbol at the top of the page.
2. On the Teacher menu, click Locked Item.
When a Teacher symbol is locked, its handles look like this ▲. You cannot move, replace or delete a locked symbol.

Use pictures and words to tell five facts about a topic.

**Listening to the text in the diagram**

Speech supports auditory learners and helps students develop important text-picture-meaning connections. Using the Listen tool, all text can be read aloud.

1. Select the *Topic* symbol at the center of the diagram.
2. On the **Symbol palette**, click the **Pick Library** button, and then under **Animals and Plants**, click **Wild Animals**.
3. Click the *elephant* symbol to replace the *Topic* symbol.
4. In the *elephant* symbol, select the word *Topic*, and then type **Facts About Elephants**.
5. Press the Escape key to end text editing and select the symbol.
Now your diagram looks like this.

6. On the Picture toolbar, click the Listen button.

7. Select the Facts About Elephants symbol.
   The computer reads the text in the symbol.
8. To turn the Listen tool off, click the Listen button again.

**Recording words or narration**

To support emerging readers, you can record words or narration and attach it to a symbol.

1. Select the Facts About Elephants symbol.
2. On the Sound menu, click Record.
3. To begin recording, click the **Record** button.

4. Say, “Can you find facts about the native habitats of elephants?” When you are finished, click the **Save** button.

5. To play the recording, click the speaker in the upper right corner of the **Facts About Elephants** symbol.

---

**Printing your work**

When you print from Picture View, Kidspiration always sizes your diagram to fit on one page.

1. On the **File** menu, click **Print**.

2. In the **Print** dialog box, click **Print**.
**Saving a project as an activity**

Now that you have modified the *Five Facts* diagram, save it as an activity. The Kidspiration Activity Wizard takes you step-by-step through the process of creating an activity. You can save the activity to any location.

1. On the **Teacher** menu, click **Save With Activity Wizard**.
   
   The Kidspiration Activity Wizard opens. Click **Next**.

2. Select **All Libraries**, and then click **Next**.

3. Review the **Picture View Defaults**, and then click **Next**.

4. Review the **Text Defaults**, and then click **Next**.

5. Review the **Writing View** defaults, and then click **Next**.

6. Select **Kidspiration Activities Folder**.

7. To save the activity in the “More” category in the Kidspiration Starter, click the **More** button.

8. To save the activity, click the **Save Activity** button.

   *Facts About Elephants* is now available as an activity in the Kidspiration Starter under the “More” category.

9. In the Success dialog box, click **OK**.

   The diagram closes and you return to the Kidspiration Starter. Congratulations! You have finished the Kidspiration tutorial.
Chapter 4: Working in Picture View

Working with visual ideas

In Picture View, you use symbols to show your ideas. You use links or SuperGrouper categories to show how these ideas flow or connect. After you get your ideas down, it is easy to arrange, group and sort your ideas. You also can add text to symbols and links. Kidspiration gives you many tools to help you capture and organize your ideas visually.

Starting a new diagram

1. Start Kidspiration.
   –or–
   On the File menu, click New.
2. Under New, click the Picture button.
Working with symbols

Adding symbols to a diagram

There are several ways to add symbols to a diagram:

• You can add a symbol using the Symbol palette. Drag a symbol from the palette to add it to your diagram.

• You can add linked symbols using the Add Symbol tool. Click the Add Symbol button on the Picture toolbar. If no symbol is selected, clicking the Add Symbol button adds an unlinked symbol to your diagram.

Otherwise, a new symbol appears that is linked to the currently selected symbol. Click the Add Symbol button again, and another symbol appears connected to the selected symbol. Continue clicking to add as many symbols as you need.

• You can click anywhere and type. A symbol with your idea appears automatically.

Adding a symbol using the Symbol palette

Use the Symbol palette to add symbols to your diagram.

To add a symbol using the Symbol palette:

• Drag the symbol to your diagram.

Tip: To change the shape of a symbol, select it, and then click a new symbol on the Symbol palette.

Adding a symbol using the Add Symbol tool

Use the Add Symbol tool to add linked symbols to a diagram. Each symbol you add is connected to the currently selected symbol. The Add Symbol tool is great for brainstorming when you want to add a number of linked symbols to one idea.
To add a symbol using the Add Symbol tool:

1. Select the symbol to which you want to connect the new symbol.
2. On the Picture toolbar, click the Add Symbol button.

—or–
If no symbol is selected, click the Add Symbol button to add a new symbol. Click the Add Symbol button again to add a symbol connected to the first.

Adding a symbol using point and type

• Click anywhere on the background of the diagram, and then type.
  A symbol is automatically created containing the text you typed.

Changing the shape of a symbol

1. Select the symbol that you want to change.
2. On the Symbol palette, click the new symbol.

Showing or hiding symbol captions in Picture View

To add flexibility to lessons, you can show or hide the symbol captions in Picture View.

Note: Showing symbol captions labels all symbols in a diagram.
To hide symbol captions in Picture View:

- On the Formatting toolbar, click the Hide Captions button.

To show symbol captions in Picture View:

- On the Formatting toolbar, click the Show Captions button.

Adding text to a symbol

Some symbols are shapes, such as a circle or oval, which let you type an idea inside the symbol. Other symbols are captioned, with space below the symbol for text. When you select a symbol, a dotted line surrounds the symbol’s text area.

**Tip:** Clicking the Hide/Show Captions button on the Formatting toolbar two times automatically labels all captioned symbols.

- To add text to a symbol, select the symbol, and then type.

To edit the text in a symbol, select the symbol and click inside the text area to make your changes.
Changing symbol text

You can change the symbol text that appears below the symbol in Picture View.

To change symbol text:

1. Select the text you want to change.
2. Type the text you want.

Moving a symbol

• To move a symbol, drag it to the new location.
   Any links attached to the symbol are rearranged automatically.

Creating a Teacher symbol that appears only in Picture View

You can format a symbol so it appears only in Picture View. This eliminates the transfer of irrelevant information to Writing View. For example, you might create symbols containing instructions in Picture View, but you do not want the instructions to appear in Writing View.

To create a Teacher symbol that appears only in Picture View:

1. Select the symbol you want to appear only in Picture View.
2. On the Teacher menu, click Teacher Symbol.
   When the selected symbol is a Teacher symbol, a check mark appears next to the command.
The handles on a Teacher symbol look like this △.

Locking the position of a symbol

You can lock the position of a symbol to ensure that students do not accidentally move, delete or replace specific symbols or SuperGrouper shapes. When a symbol is locked, you can still format the symbol and edit the text in the symbol.

To lock the position of a symbol:

1. Select the symbol.
2. On the Teacher menu, click Locked Item.

When a symbol is locked, a check mark appears next to the command.

When a symbol is locked, its handles look like this □.
When a SuperGrouper shape is locked, its handles look like this ⭐.
When a Teacher symbol is locked, its handles look like this △.
Aligning symbols or SuperGrouper shapes

When you are fine-tuning a diagram you may find it useful to align symbols and SuperGrouper shapes in various ways.

Note: You cannot align locked items.

To align symbols or SuperGrouper shapes:

1. Select the symbols or SuperGrouper shapes you want to align.
   You need to select at least two symbols or SuperGrouper shapes to make the Align command available.

2. On the Teacher menu, click Align, and then click the arrangement you want.
   Each choice on the Align submenu shows how the selected objects will align.
   The objects rearrange themselves to reflect your choice.

See Also

“Selecting multiple symbols” on page 100.

Spacing symbols or SuperGrouper shapes evenly

Use the Evenly Space command when you want equal amounts of space between certain symbols or SuperGrouper shapes.

Note: You cannot evenly space locked items.

To space symbols or SuperGrouper shapes evenly:

1. Select the symbols or SuperGrouper shapes you want to arrange.
   You need to select at least three symbols or SuperGrouper shapes to make the Evenly Space command available.

2. On the Teacher menu, click Evenly Space, and then do one of the following:
   • Click Vertical to make the vertical distance between the selected items equal.
     —or—
• Click **Horizontal** to make the horizontal distance between the selected items equal.

**See Also**

“Selecting multiple symbols” on page 100.

### Drawing a symbol using the Symbol Maker tool

You can use the Symbol Maker tool to draw your own symbols. After you create a symbol, you can install it in the symbol libraries so it is available for other projects.

**To draw a symbol using the Symbol Maker tool:**

1. On the Picture toolbar, click the **Symbol Maker** button.

- The **Tool palette** is on the left side of the dialog box.
- The **Color palette** is on the right side of the dialog box.
- The area where you draw—the canvas—is in the center of the dialog box.
- The **Nib palette** (for the Paintbrush, Spray Can, Line, Circle and Square tools) is at the bottom of the dialog box.
2. To select a tool, click it on the **Tool palette**.
   - For the Paintbrush, Spray Can, Line, Circle or Square tool, click a nib on the **Nib palette** to define the shape and width of the line.
   - or –
   - For the Stamp tool, click a stamp on the **Stamp palette**.

3. To choose a color for the selected tool, click a color on the **Color palette**.

4. Draw on the canvas by dragging the selected tool.

5. Click **Done** to place the new symbol on the diagram.

   After you add the new symbol to the diagram, you can make changes to it by selecting it, and then clicking the **Symbol Maker** button on the **Picture** toolbar. **Note:** Once you install the graphic in the symbol libraries you cannot edit it.

**See Also**

“Inserting custom symbols and graphics into the symbol libraries” on page 148.
About the Symbol Maker tools

The Kidspiration Symbol Maker has tools for creating your own symbols. You can draw a variety of lines and shapes, and fill the shapes with different colors. You can use the Stamp tool to add images, numbers and letters. After you create a symbol you can add it to the symbol libraries.

Use this tool … … to do this

Paintbrush
Draw a solid freeform line.

Paint Bucket
Fill the background or a specific contiguous area of the drawing with the selected color.

Spray Can
Draw a freeform line with a spray paint pattern.

Line
Draw a solid straight line

Circle
Draw the outline of a circle.

Solid circle
Draw a solid circle.

Square
Draw the outline of a square.

Solid square
Draw a solid square.
You can draw a variety of lines using the Symbol Maker tools.

To draw a freeform line:

1. On the Tool palette, click the Paintbrush tool.

Select a rectangular section of the drawing. To move the selection, click inside the selection and drag.

Select part of the drawing. To move the selection, click inside the selection and drag.

Add a stamp to the drawing.

Undo the last action.

Remove part of the drawing.

Remove everything on the drawing.
2. On the **Nib palette**, click the shape and width you want the line to be.

3. On the **Color palette**, click a color.

4. On the canvas, click where you want to begin, and then drag. Release the mouse button where you want the line to end.

**To draw a freeform line with a spray paint pattern:**

1. On the **Tool palette**, click the **Spray Can** tool.

2. On the **Nib palette**, click the shape and width you want the line to be.

3. On the **Color palette**, click a color.

4. On the canvas, click where you want to begin, and then drag. Release the mouse button where you want the line to end.

**To draw a straight line:**

1. On the **Tool palette**, click the **Line** tool.
2. On the **Nib palette**, click the shape and width you want the line to be.

   ![Nib palette]

3. On the **Color palette**, click a color.

4. On the canvas, click where you want to begin, and then drag. Release the mouse button where you want the line to end.

   To constrain the Line tool to a horizontal, vertical or 45-degree angle, press the **Shift** key while drawing the line.

### Drawing shapes using the Symbol Maker tools

You can draw circles and squares using the Symbol Maker tools.

**To draw the outline of a circle:**

1. On the **Tool palette**, click the **Circle** tool.

   ![Circle tool]

2. On the **Nib palette**, click the shape and width you want the outline of the circle to be.

   ![Nib palette]

3. On the **Color palette**, click a color.
4. On the canvas, drag until the circle is the size and shape you want.
To maintain a circular shape, press the Shift key while you draw.

To draw a circle that is filled:
1. On the Tool palette, click the Solid Circle tool.

2. On the Color palette, click a color.
3. On the canvas, drag until the circle is the size and shape you want.
To maintain a circular shape, press the Shift key while you draw.

To draw the outline of a square:
1. On the Tool palette, click the Square tool.

2. On the Nib palette, click the shape and width you want the outline of the square to be.

3. On the Color palette, click a color.
4. On the canvas, drag until the square is the size and shape you want.
To maintain equal-length sides, press the Shift key while you draw.
To draw a square that is filled:

1. On the Tool palette, click the Solid Square tool.

2. On the Color palette, click a color.

3. On the canvas, drag until the square is the size and shape you want.
   To maintain equal-length sides, press the Shift key while you draw.

Using the Stamp tool

The Stamp tool enables you to add a variety of images to a symbol. Developed for K-5 students, stamps are easy to fill and color.

To add an image using the Stamp tool:

1. On the Tool palette, click the Stamp tool.

2. On the Stamp palette, click the stamp you want.
   To view more stamp choices, click the up and down arrows on the Stamp palette.

3. On the Color palette, click a color.

4. Click the location on the drawing where you want the stamp to appear.
To select the stamp size:

- Click the **Small**, **Medium** or **Large** button.

To see a preview of the stamp before you add it to the drawing, point to the canvas.

To rotate the stamp:

- Click the **Rotate** button.

Each time you click the **Rotate** button, the stamp rotates 90 degrees. Click the **Rotate** button until the stamp is in the desired position.

To see a preview of the rotated stamp before you add it to the drawing, point to the canvas.

To flip the stamp horizontally:

- Click the **Flip** button.

To see a preview of the flipped stamp before you add it to the drawing, point to the canvas.
**Filling an area with a color using the Symbol Maker tools**

You can fill the background or any other contiguous area of the drawing when you create a symbol using the Symbol Maker tool.

**To fill an area with a color:**
1. On the Tool palette, click the Paint Bucket tool.

2. On the Color palette, click a color.
3. Click the area you want to fill.

**Selecting, moving, copying and pasting using the Symbol Maker tools**

You can select, move, copy and clear areas of the drawing when you create a symbol using the Symbol Maker tool.

**To select a rectangular area:**
1. On the Tool palette, click the Select tool.

2. On the canvas, drag until the rectangle encloses the area you want to select.
3. To move the selection, click inside the selection and drag.
4. To delete the selection, drag it off the canvas.

**To select an irregular area:**
1. On the Tool palette, click the Lasso tool.
2. On the canvas, click where you want the shape to begin, and then drag. Release the mouse button when the shape is the size and shape you want. Release the mouse button when you have selected the area you want.

3. To move the selection, click inside the selection and drag.

4. To delete the selection, drag it off the canvas.

**To copy and paste a selection:**

- Press the **Command** key (Macintosh) or **Ctrl** key (Windows) when dragging the selected area.

**To draw using the selected area as a brush:**

- Press the **Shift** key when dragging the selected area.

**Clearing part or all of the drawing using the Symbol Maker tools**

**To clear part of the drawing:**

1. On the Tool palette, click the **Eraser** tool.
2. On the **Nib palette**, click the shape and width you want the tool to have when you erase.

   To erase a narrow area, select a small nib. For a wide area, select a large nib.

   ![Nib palette options](image)

3. On the canvas, drag the **Eraser** tool over the area you want to remove.

   **To clear all of the drawing:**
   
   - On the **Tool palette**, click the **Clear All** tool.

   ![Trash can icon]

**Working with links**

**Connecting symbols using links**

Links show relationships between ideas. When you add links in Kidspiration, they automatically adjust as you move symbols or add symbols to your diagram.

**To connect symbols using links:**

1. Click the **Link Symbols** button.
2. Click the symbol where you want the link to start, and then click the symbol where you want the link to end.

![Diagram showing how to create a link](image1)

Select the symbol, and then click the Link Symbols button ...

... and then click the symbol you want to create a link to.

**Moving a link**

You can drag the end of a link to another location on the current symbol or to a different symbol.

**To move a link:**

1. Click the link.
2. Drag the end of the link to the new location.

![Diagram showing how to move a link](image2)

Select the end of the link you want to move ...

... and then drag it to the new location.
Reversing the direction of a link

Changing the direction of a link reverses the relationship between the ideas and affects the hierarchy of items in Writing View.

To reverse a link:
1. Select the link or links that you want to reverse.

2. On the Formatting toolbar, click the Arrow button until the arrowheads on the links are reversed.

Adding text to a link

You can add text to a link to expand your ideas or explain a relationship between two ideas. When you select a link, a dotted line surrounds the link’s text area.

• To add text to a link, select the link, and then type.
  To edit the text on a link, select the link and click inside the text area to make your changes.
Moving the text on a link

- To move the text on a link, select the link, and then drag the handle on the text box to adjust the location of the text.

Working with SuperGrouper categories

Sorting ideas using SuperGrouper categories

SuperGrouper categories provide an easy way to create logical groupings of ideas. For example, you might create two SuperGrouper categories—one titled “Things that are alive” and one titled “Things that are not alive”—and ask students to put appropriate symbols in each category. To simplify an exercise like this, you can create a custom symbol library that contains symbols of your choosing.

A SuperGrouper category has a text area at the top for labeling the group. In Writing View, the SuperGrouper title assumes a top-level position, and the symbols it contains appear as supporting ideas below the SuperGrouper category.
Adding SuperGrouper shapes to a diagram

There are several ways to add SuperGrouper shapes to a diagram:

- You can add a SuperGrouper shape using the SuperGrouper menu. On the Picture toolbar, click the SuperGrouper button, and then click a shape on the palette to add it to your diagram.

- The Venn diagram SuperGrouper shape can be used in lessons where students identify and categorize differences and similarities between objects and ideas. On the Picture toolbar, click the SuperGrouper button, and then click Venn.

- You can transform any symbol into a SuperGrouper shape. Select the symbol. On the Picture toolbar, click the SuperGrouper button, and then click Create SuperGrouper.

To add a SuperGrouper shape to a diagram:

1. On the Picture toolbar, click the SuperGrouper button.

2. Click the SuperGrouper shape you want to add to the diagram.

Tip: Any symbols that are selected when you add a SuperGrouper category are automatically added to the SuperGrouper category.
To add a Venn diagram SuperGrouper shape to a diagram:

1. On the Picture toolbar, click the SuperGrouper button.

2. On the SuperGrouper menu, click Venn.

The Venn diagram SuperGrouper shape appears on your diagram.

You can change the “Group A” and “Group B” titles and begin adding symbols to all three areas of the diagram.

To create a SuperGrouper shape:

1. Select the symbol.
2. On the Picture toolbar, click the SuperGrouper button.

3. On the SuperGrouper menu, click Create SuperGrouper.

Adding a title to a SuperGrouper category

You can add a title to the top of a SuperGrouper category.

• Select the SuperGrouper category, and then type.

Adding symbols to a SuperGrouper category

You can add symbols to a SuperGrouper category using any of the following methods:

• Drag a symbol into the SuperGrouper category.
  –or–
• Select the SuperGrouper category, and then click the **Add Symbol** button.

You can add as many default symbols to the SuperGrouper category as you want.

–or–

• Select the symbols that you want to add to the SuperGrouper category, and then add the SuperGrouper category to your diagram.

**Removing a symbol from a SuperGrouper category**

• To remove a symbol from a SuperGrouper category, drag the symbol to another location on your diagram.

–or–

To remove the symbol from the diagram, select it, and then click the **Clear** button on the **Picture** toolbar.

–or–

Drag it back to the **Symbol palette**.
Cutting, copying and pasting symbols and links

Selecting a symbol

- To select a symbol, click it.

When you select a symbol, a resize handle appears at each corner of the symbol, and a dotted line surrounds the symbol’s text area.

Selecting multiple symbols

- To select multiple symbols, press **Shift**, and then click each symbol you want to select.
  
  –or–

  Drag the pointer so the marquee surrounds the symbols you want to select.

See Also

“Selecting part of a diagram” on page 101.

Selecting both symbols and links

- To select both symbols and links, press **Shift**, and then click each symbol and link you want to select.

  –or–

  Drag the pointer so the marquee surrounds the symbols you want to select.
Selecting part of a diagram

- Drag the pointer so the marquee surrounds the part of the diagram you want to select.

Selecting everything on a diagram

- To select everything on a diagram, click Select All on the Edit menu.

Removing a symbol

- To remove a symbol from a diagram, select it, and then click the Clear button on the Picture toolbar.

  –or–
  
  Select the symbol, and then press the Delete key.

  –or–
  
  Drag the symbol back to the Symbol palette.
Removing a link
When you remove a link, you remove the relationship between the symbols that are connected by the link.

To remove a link:
1. Select the link you want to remove.
2. On the Picture toolbar, click the Clear button.
   –or–
   Press the Delete key.

Removing a symbol and its links
When you remove a symbol, you automatically remove any links that connect it to other symbols.

To remove a symbol and its links:
1. Select the symbol you want to remove.
2. On the Picture toolbar, click the Clear button.
   –or–
   Press the Delete key.
   –or–
   Drag the symbol back to the Symbol palette.

Cutting and pasting symbols
1. Select the symbols you want to remove from their current location and paste into another location in your diagram.
2. On the Edit menu, click Cut.
3. Click where you want the selection to appear, and then click Paste on the Edit menu.

Tip: To select multiple symbols, press Shift, and then select each symbol.

Copying and pasting symbols
1. Select the symbols you want to paste into another location in your diagram.
2. On the Edit menu, click Copy.
3. Click in your diagram where you want the selection to appear, and then click Paste on the Edit menu.

Undoing changes
• To undo the last change you made, click the Undo button.

Using custom symbols and graphics

Inserting a graphic into a diagram
You can insert graphics created in other programs into a diagram. On the Macintosh, you can insert PICT, JPEG and GIF files. In Windows, you can insert WMF, BMP, JPEG and GIF files.

To insert a graphic into a diagram:
1. On the File menu, click Import a Graphic.
2. Open the folder where the graphic is located.
3. Click the graphic file in the list, and then click Open.

Tips:
• You can drag and drop graphics files into a diagram. Turn off Hide Desktop in Application Options (click Application
Options on the Teacher menu) before you drag and drop a graphics file.

- You can copy and paste graphics into a diagram. Copy the graphic, and then open your diagram and click Paste on the Edit menu.

See Also

“Inserting custom symbols and graphics into the symbol libraries” on page 148.

Changing the view

Magnifying or reducing the view of a diagram

- To magnify or reduce the view of a diagram, click the Magnify button in the lower left corner of the Kidspiration window.
  - Click once to fit the entire diagram in the window.
  - Click twice to show the entire page.
  - Click three times to view the diagram at actual size.

Fitting the entire diagram in the window

- To fit the entire diagram in the window, click the Magnify button in the lower left corner of the Kidspiration window until the entire diagram fits in the window.

Switching to Writing View

- To view your diagram as a written project, click the Go to Writing button on the Picture toolbar.
Chapter 5: Working in Writing View

Working with written ideas

In Writing View, you can expand on the ideas you captured in Picture View. Each symbol becomes a topic with a notes area where you can add details. Icons help emerging readers develop important word-meaning skills. You can even start a writing project from scratch using the Kidspiration tools to arrange, organize and expand ideas.

Starting a new writing project

1. Start Kidspiration.
   –or–
   On the File menu, click New to return to the Kidspiration Starter.
2. Under New, click the Writing button.

Using the ideas in a diagram to begin writing

You can use the ideas in a diagram to begin writing by switching to Writing View. In Writing View, symbol text becomes ideas. When a symbol has no text, the symbol’s label appears. For example, a symbol with the label “Sun” becomes the idea “Sun” in Writing View. This special function, called picture-to-topic
(click **Picture-to-Topic** on the **Teacher** menu), helps emerging readers and writers associate words with images.

If you do not want symbol labels to appear as ideas in Writing View, you can turn off the picture-to-topic setting.

**To use the ideas in a diagram to begin writing:**

1. Add symbols and words that represent ideas to your diagram.
   
   If you use symbols, they must be pictorial, for example a symbol of a dog or a sun, to take advantage of picture-to-topic. Basic symbols such as ovals and rectangles are not labeled.

2. To switch to Writing View, click the **Go to Writing** button on the **Picture** toolbar.

   ![Diagram](image)

   The symbol labels appear as ideas in Writing View.

**See Also**

“Changing symbol text” on page 79.

“Turning picture-to-topic on or off” on page 146.
Adding an idea in Writing View

1. On the Writing toolbar, click the Add Idea button, and then type the new idea.

2. If necessary, adjust the location of the idea by doing one of the following:
   • Drag the new idea to the location where you want it.
   –or–
   • To move the idea up or down a level in the hierarchy, click the Move Left button or Move Right button.

Adding details to an idea

You can expand your ideas by adding details—also called notes. A line separates an idea from its notes. The notes area is always available. As you add more notes text, the notes area automatically expands.

To add details to an idea:
   • Click in the area below the idea, and then type.
Moving an idea up or down

- To move an idea up or down, point to the top or left edge of the idea. When the ~ appears, drag the idea to the new location. You can also drag an idea to the left or right to adjust its level.

Moving an idea left or right

You can change the level of an idea in the hierarchy by moving it to the left or to the right.

To move an idea left or right:

1. Select the idea.
2. On the Writing toolbar, do one of the following:
   - To move the idea up one level in the hierarchy, click the Move Left button.
   - or -
   - To move the idea down one level in the hierarchy, click the Move Right button.
Locking an idea in Writing View

You can lock the level of an idea in Writing View. When an idea is locked, you cannot change its level in the hierarchy. However, you can still move the idea up or down to change where it is located in the order of ideas. You can also format the idea and edit the text.

To lock the level of an idea in Writing View:
1. Select the idea.
2. On the Teacher menu, click Locked Item.
   When an idea is locked, a check mark appears next to the command.
   When an idea is locked the corners of the idea look like this.

The handles on an idea indicate when the idea is locked.

You cannot replace, delete or change the level of a locked idea.

Selecting ideas in Writing View

Selecting an idea in Writing View

• To select an idea in Writing View, click the top or left edge of the symbol.
   When you select an idea, the border that surrounds the idea becomes bold.
Selecting multiple ideas in Writing View

- To select multiple ideas in Writing View, press Shift, and then click the top or left edge of each idea you want to select.

Selecting all the ideas in Writing View

- To select all the ideas in Writing View, click Select All on the Edit menu.

Removing an idea in Writing View

When you remove an idea in your writing project, all supporting ideas below that idea are removed as well.

- To remove an idea, select it, and then click the Clear button on the Writing toolbar.

Cutting, copying and pasting ideas in Writing View

When you copy an idea, you also copy any supporting ideas below the idea. You cannot copy an idea when you are in text editing.

To copy and paste ideas in Writing View:

1. Select the ideas that you want to paste into another location in your project.
2. On the Edit menu, click Copy.
3. Click where you want the selection to appear.
4. On the Edit menu, click Paste.

_Tip:_ To select multiple ideas, press _Shift_, and then select each idea.

**See Also**

“Selecting an idea in Writing View” on page 109.

“Editing text in an idea” on page 123.

**Cutting and pasting ideas in Writing View**

When you click _Cut_ on the Edit menu, you also remove any supporting ideas below the idea. You cannot cut an idea when you are in text editing.

**To cut and paste ideas in Writing View:**

1. Select the idea or ideas that you want to remove from the current location and paste into another location in your project.
2. On the Edit menu, click _Cut_.
3. Click in your project where you want the selection to appear.
4. On the Edit menu, click _Paste_.

_Tip:_ To select multiple ideas, press _Shift_, and then select each idea.

**See Also**

“Selecting an idea in Writing View” on page 109.

“Editing text in an idea” on page 123.

**Undoing changes**

- To undo the last change you made, click the _Undo_ button.
Changing the view

Switching to Picture View

- To view your writing project as a diagram, click the Go to Pictures button on the Writing toolbar.
Chapter 6: Changing the Appearance of Projects

Formatting text

You can change the look of the text in Picture View or Writing View using font, text size, text style and color. You can change all the text in a symbol, link or idea by selecting the symbol, link or idea. You can change the formatting of words or single characters by selecting the words or characters.

Changing the font

1. Select the symbol, link, idea or words that you want to change.
2. On the Formatting toolbar, click in the Font box, and then click a font on the list.

   When you select a symbol, link or idea, and change its font, the change applies to new symbols, links and ideas. New symbols and links are not affected by font changes to text selections within symbols, links and ideas.

Changing the text size

1. Select the symbol, link, idea or words that you want to change.
2. On the Formatting toolbar, click the Text Size box, and then click a text size on the list.

   When you select a symbol, link or idea, and change its text size, the change applies to new symbols, links and ideas. New symbols and links are not affected by text size changes to text selections within symbols, links or ideas.
Applying bold formatting to text
1. Select the symbol, link, idea or words that you want to change.

2. On the Formatting toolbar, click A.
   When you select a symbol, link or idea, and apply bold formatting, the change applies to new symbols, links and ideas. New symbols and links are not affected by bold formatting applied to text selections within symbols, links or ideas.

Applying italic formatting to text
1. Select the symbol, link, idea or words that you want to change.

2. On the Formatting toolbar, click A.
   When you select a symbol, link or idea, and apply italic formatting, the change applies to new symbols, links and ideas. New symbols and links are not affected by italic formatting applied to text selections within symbols, links or ideas.

Underlining text
1. Select the symbol, link, idea or words that you want to change.

2. On the Formatting toolbar, click A.
   When you select a symbol, link or idea, and apply underline formatting, the change applies to new symbols, links and ideas. New symbols and links are not affected by underline formatting applied to text selections within symbols, links or ideas.

Changing the color of text
1. Select the symbol, link, idea or words that you want to change.

2. On the Formatting toolbar, click A, and then click the color that you want.
When you select a symbol, link or idea, and change its colors, the change applies to new symbols, links and ideas. New symbols and links are not affected by changes to text selections within symbols, links and ideas.

**Formatting symbols and SuperGrouper shapes**

You can change the look of symbols and SuperGrouper shapes using color, line thickness and size.

**Changing the line width of a symbol or SuperGrouper shape**

You can choose from three line widths for symbols and SuperGrouper shapes.

**To change line width of a symbol or SuperGrouper shape:**

1. Select the symbol or SuperGrouper shape you want to change.

2. On the **Formatting** toolbar, click ![line width icon] until the outline of the symbol or SuperGrouper shape is the width you want. Any new symbols or SuperGrouper shapes you add will have the same line width.
Changing the colors of a symbol or SuperGrouper shape

You can change the look of symbols and SuperGrouper shapes using color. You can select one symbol or SuperGrouper shape and then change the colors of the selection. You can also select multiple basic symbols (for example, oval or rounded rectangle) and change the colors of all the symbols at one time.

To change the colors of a symbol or SuperGrouper shape:

1. Select the symbol or SuperGrouper shape.
   
   The **Symbol Colors** tool appears on the **Formatting** toolbar.

   ![Symbol Colors tool]

   Only the colors that appear in the symbol appear in the Symbol Colors tool.

2. Click the color you want to change, and then click a new color to replace the existing color.
   
   If you change the colors of a basic symbol (oval, rectangle, text or rounded rectangle), any new basic symbols you add will be the same colors.

   **Note:** You cannot change the colors of photographic images.

To revert to a symbol’s original colors:

When you change the colors in a multicolor symbol, an **X** appears in the **Symbol Colors** tool. Click the **X** to revert to the symbol’s original colors.

![Click to revert to the symbol's original colors]
Changing the size of a symbol or SuperGrouper shape

You can change the size of symbols and SuperGrouper shapes.

To change the size of a symbol or SuperGrouper shape:

1. Select the symbol.
2. Drag the lower right handle to resize a symbol proportionally.
   —or—
   Drag any of the other handles to stretch the symbol vertically or horizontally.

   ![Sun symbol with handle selected]

   Select the lower right handle ...
Formatting links

You can change the look of links using color, line width, line style and arrowhead style.

Changing the width of a link

You can choose from three line widths for a link. You can also make a link a dashed line.

To change the width of a link:

1. Select the link or links that you want to change.

2. On the Formatting toolbar, click \[\text{line width}\] until the links are the line width you want.
   Any new links you create will be the same line width.

Creating a dashed link

1. Select the link or links you want to change.

2. On the Formatting toolbar, click \[\text{dashed lines}\] until the links are dashed lines.
   Any new links you create will be dashed lines.

Changing arrowhead style

You can choose from two arrowhead styles: single arrowhead or double arrowhead. You can also choose a link with no arrowhead. You can use a single arrowhead to indicate a one-way relationship between symbols. A double arrowhead indicates a two-way relationship between symbols. For example, in a diagram describing a journey from one place to another you might use
single arrowheads. In a diagram showing how you and a friend communicate using email, you might use double arrowheads.

**To change arrowhead style:**

1. Select the link or links you want to change.

2. On the **Formatting** toolbar, click ![arrowheads](image) until the links have the arrowhead style you want.

   Any new links you create will have the same arrowhead style.

**See Also**

“Reversing the direction of a link” on page 95.

**Changing the color of a link**

1. Select the link.

   The **Link Color** tool appears on the **Formatting** toolbar.

2. Click the color to change it, and then click a new color to replace the existing color.

   Any new links you create will be the new color.

**Formatting the page**

You can change the look of the page by changing the background color, changing the colors of the lined paper, changing the prefix style and showing or hiding the lined paper.

**Changing the background color of a project**

Changing the background color of your project is another way to customize the look of your work. For instance, if you are working
on a project about the world’s oceans, you might want to use a blue background.

**To change the background color of your project:**

1. On the **Goodies** menu, click **Background Color**.
2. Click the color that you want.

   When you print your project on a black and white printer, the background color appears as a shade of gray.

**Changing the colors of the lined paper**

Changing the colors of the lined paper in Writing View is another way to customize the look of your work.

**To change the colors of the lined paper:**

1. On the **Goodies** menu, click **Lined Paper Colors**.
2. Click a color to change it.

   When you print on a black and white printer, the colors of the lined paper appear as shades of gray.

**Choosing the prefix style**

There are five prefix styles to choose from. You can also choose to have no prefix. The default prefix style is “Symbol,” which displays the Picture View symbols at the beginning of each idea.

**To choose the prefix style:**

- On the **Formatting** toolbar, click until you see the prefix style you want.
**Showing or hiding the lined paper**

For some projects, you may want your writing to appear in a more continuous format. Hiding the lined paper removes the visual distinction between ideas in Writing View.

- To show or hide the lined paper, click 📝 on the **Formatting** toolbar.
Chapter 7: Editing Text

**Editing text in a symbol**

- To add text to or edit text in a symbol, select the symbol, click in the symbol’s text area, and then type.

  Basic symbol shapes have a text area inside the symbol.

- Captioned symbols have a text area below the symbol.

**Editing text in an idea**

- To edit text in an idea, click in the idea, and then type.

  The border around the idea becomes a dashed line when you are adding or editing text.
Selecting a word

There are two ways to select a word.

• Double-click the word.

–or–

• Click in front or behind the word, and then drag the mouse pointer across the word.

Copying and pasting text

1. Select the text you want to paste into another place in your project.

2. On the Edit menu, click Copy.

3. Click in your project where you want the selection to appear, and then click Paste on the Edit menu.

Cutting and pasting text

1. Select the text you want to cut and paste into another place in your project.

2. On the Edit menu, click Cut.

3. Click in your project where you want the selection to appear, and then click Paste on the Edit menu.

Checking your spelling

1. On the Goodies menu, click Spell Check to check the spelling in your project.

2. When the spelling checker finds a misspelled word, you have several options:

• To change the spelling of a word to the suggested dictionary spelling, click Change.

–or–
• To keep the spelling of the word as it is throughout the project, click **Ignore All**.

—or—

• To keep the spelling of the word in this instance only, click **Ignore Once**. The spelling checker will continue to find other occurrences of this word.

—or—

• To add the word to the user dictionary, click **Add Word**. After you add a word to the dictionary, the spelling checker will not suggest other spellings for the word.

**Editing the user dictionary**

You can add words to and edit words in the dictionary as you are checking the spelling in your project.

**To edit the user dictionary:**

1. On the **Goodies** menu, click **Spell Check**.

2. Do one of the following:

   • To add a word to the user dictionary, click **Add Word**. After you add a word to the dictionary, the spelling checker will not suggest other spellings for that word.
   
   —or—

   • To edit the spelling of a word, click **Edit**. Change the spelling of the word to your preferred spelling. The spelling checker will use the new spelling for the word.
Chapter 8: Using Audio in Projects

You can use audio in your Kidspiration projects in several ways:

• Talking interface
  For developing readers, the talking interface reads menus, buttons and other on-screen program elements. You can turn the talking interface on or off in Application Options (click \textit{Application Options} on the \textit{Teacher} menu).

• Listen tool
  ![](ear.png)
  The Listen tool helps students with reading and writing by reading the words in their projects.

• Record command (click \textit{Record} on the \textit{Sound} menu)
  Students use the Record command to record sounds and attach them to symbols or ideas to expand and reinforce learning. Teachers can also record instructions for students to use in an activity.

Choosing the voice the computer uses

You can choose the voice the computer uses when you use the Listen tool or the talking interface.

\textbf{To choose the voice that the computer uses:}

1. On the \textit{Sound} menu, click \textit{Voice}.
2. Click the voice in the list box, and then click \textit{Choose}.
Reading the text in the Kidspiration interface

The computer reads all the text in the Kidspiration interface, including menus, buttons and dialog boxes, when the talking interface is turned on in Application Options (click Application Options on the Teacher menu).

To read the text in the Kidspiration interface:

- Point to a menu or button.
  The computer reads the text in the menu or button.

See Also
“Turn the talking interface on or off” on page 143.

Listening to the text in a project

The Listen tool is available only when the Listen tool is turned on in Application Options (click Application Options on the Teacher menu). You can use the Listen tool to read any text that is added to a project in either Picture or Writing View.

To listen to the text in a project:

1. Click the Listen button.

2. Click the object you want the computer to read.

3. To turn the Listen tool off, click the Listen button.

Recording a sound or words

You can record a sound or words and attach them to a symbol or idea to expand and reinforce learning. The Record command is only available when Record Sounds is turned on in Application Options.
Options (click **Application Options** on the **Teacher** menu). Your computer needs a microphone to record sounds.

**To record a sound or words:**

1. Select the symbol or idea.
2. On the **Sound** menu, click **Record**.
3. In the recording controls box, click the **Record** button to begin recording.
4. Generate the sound you want to record.
   The maximum length of a recorded sound is fifteen seconds. You can click **Stop** at any time to end recording.
5. When you finish recording, click **Save** to save the recording and attach it to the selected symbol or idea.

In Picture View, a speaker symbol 🎧 appears in the upper right corner of a symbol when a recorded sound is attached. In Writing View, a speaker symbol appears to the left of an idea when a recorded sound is attached.

**Note:** You cannot attach a recorded sound to a link.

**See Also**

“Turning sound recording on or off” on page 144.
Playing a recorded sound

- To play a recorded sound, click the speaker on the symbol or idea.

Erasing a recorded sound

1. Select the symbol or idea.
2. On the Sound menu, click Erase.
Chapter 9: Printing

Printing a project

- To print a project, click Print on the File menu.
  In Picture View, a diagram always prints on one page.

See Also
“Selecting paper size” on page 132.
“Setting page orientation” on page 133.

Printing page numbers on a writing project

Page numbers appear only when you print a project in Writing View.

To print page numbers on a writing project:

1. Click the Student Name button.

2. Select the check box where indicated.
   When you print, the page numbers appear at the bottom of the page.
Printing your name at the top of the page

You can add your name to a project, so when you print, your name appears at the top of every page. Your name also appears in the title bar of the document.

**To print your name at the top of every page:**

1. On the Toolbar, click the Student Name button.

2. Type your name in the box where indicated.

3. To choose where you want your name to appear on the page, select Left, Center or Right.

   A preview of how your name will appear on the page is displayed in the box on the right side of the dialog box.

Selecting paper size

You can choose the paper size for a Kidspiration project. In Picture View, the workspace is scaled to the paper size selected in Page Setup (click Page Setup on the File menu). If you change the paper size in Picture View, the paper size also changes in Writing View.

**To select the paper size:**


2. In the Paper list, select the paper size you want (Macintosh).

   –or–

   Under Paper, select the paper size you want in the Size list (Windows).
Setting page orientation

You can choose landscape or portrait orientation for a project. In Picture View, landscape orientation is the default. In Writing View, portrait orientation is the default. If you change the page orientation in one view, it does not change in the other view.

To set page orientation:

2. Next to Orientation, click the Portrait or Landscape icon (Macintosh).
   –or–
   Under Orientation, select Portrait or Landscape (Windows).

Scaling a project for printing

In Picture View, a diagram always prints on one page. You cannot scale a diagram in Kidspiration. However, you can change the page size, and then design a diagram to fill the new page size.

See Also

“Selecting paper size” on page 132.
Chapter 10: Teacher’s Reference

Enabling or disabling the Teacher menu

The Teacher menu provides access to settings and features that allow teachers to customize Kidspiration and create their own classroom activities. When the Teacher menu is enabled, a check mark appears next to the command, and the items on the Teacher menu are available.

- To enable or disable the Teacher menu, click **Enable Teacher Menu** on the **Teacher** menu.
  
  When the Teacher menu is on, a check mark appears next to the command.

Setting a password for the Teacher menu

You can create a password for the Teacher menu to prevent students from changing teacher preferences.

*Note:* If you forget your password, you can access the Teacher menu by using the password “Kidspiration 2.”

**To create a password for the Teacher menu:**

1. On the **Teacher** menu, click **Application Options**.
2. Select the **Password Enabled** check box.
3. Click **Set Password**.
   
   The Set Password dialog box appears.
4. Type the password you want to use in the **Enter Password** box.
5. Type the password again in the **Confirm Password** box, and then click **OK**.
   
   When you enable the **Teacher** menu, you will be prompted to enter your password.
Using the Kidspiration activities

The Kidspiration activities focus on a specific subject or skill. Each activity is a separate document that includes instructions on how to use the activity. Students can complete an activity and then save it as their own project. In addition to the activities that come with Kidspiration, teachers can create their own activities or modify an existing activity.

Opening an activity

1. Start Kidspiration.
   –or–
   On the File menu, click New to return to the Kidspiration Starter.
2. Under Activities, click a category, for example “Science.”
3. Click the activity you want to open, and then click OK.

Note: You cannot open a Kidspiration 2 activity using an earlier version of Kidspiration. To use a Kidspiration 2 activity with an earlier version of Kidspiration, first open the activity in Kidspiration 2, and save it in Kidspiration 1 format.

See Also

“Saving a project in Kidspiration 1 format” on page 160.
Creating an activity

You can create a project in Picture View or Writing View, and then save it as an activity so it will be available in the Activities menu in the Kidspiration Starter. You can also save an activity in another location, for example on a server. When you save the activity, the Kidspiration Activity Wizard prompts you to choose the symbol libraries and default settings for the activity, and a name, description and location for the activity.

To create an activity:

1. Create the project in Picture View or Writing View.
   See the Tips below for creating activities.
2. Enable the Teacher menu.
3. On the Teacher menu, click Save With Activity Wizard.
4. Select All Libraries or Selected Libraries:
   • Select All Libraries to make all libraries available.
     –or–
   • Select Selected Libraries to make selected libraries available.
     • To remove a library from the list of available libraries, select it in the list, and then click Remove.
     • To remove all libraries from the list of available libraries, click Remove All.
     • To make a library available, click it in the list, and then click Select.
5. Select the default settings you want for the activity.
6. In the Activity Name box, type a name for the activity.
7. In the Description of Activity box, type a description for the activity.
   The description appears when you select from the list of activities.
8. Select the folder where you want to save the activity:
   • Select Kidspiration Activities Folder to save the activity on the same computer where the Kidspiration program is
installed. Click the category that you want the activity to appear under, for example “Science,” and then click Save Activity.

—or–

• Select Another Location to save the activity to a location other than the computer where the Kidspiration program is installed, for example a server. Click Save Activity. Navigate to the folder where you want to save the activity.

**Tips:**

• **Numbered Steps:** Many of the Kidspiration activities include step-by-step instructions. To create numbered steps in your own activities, use the numbered symbols under **Numbers and Letters** on the **Symbol palette**.

• **Lock Items:** Freeze the position of items, for example SuperGrouper shapes in an activity, using the **Locked Item** command on the **Teacher** menu. Locking items prevents students from accidentally moving, replacing or deleting specific symbols or SuperGrouper shapes.

• **Custom Symbol Libraries:** If you want specific symbols to be available for an activity, you can create a custom symbol library that contains the symbols you want, and then select the custom library as the Default Library for the activity. **Note:** The custom symbol library must be copied to each computer.

• **Publish Options:** In the Kidspiration Activity Wizard, select the options that control how the project looks when you transfer it to a word processor using the **Publish** tool.

**See Also**

“Locking the position of a symbol” on page 80.

“Locking an idea in Writing View” on page 109.

“Creating a new symbol library” on page 154.

“Publishing a project in a word processor” on page 157.
Modifying an activity

Kidspiration comes with a variety of activities for you to use in the classroom. You may want to modify an activity in some cases.

To modify an activity:

1. Open the activity.
2. Make any changes.
3. Enable the Teacher menu.
4. On the Teacher menu, click Save With Activity Wizard.
5. Select All Libraries or Selected Libraries:
   - Select All Libraries to make all libraries available.
   - Select Selected Libraries to make selected libraries available.
   - To remove a library from the list of available libraries, select it in the list, and then click Remove.
   - To remove all libraries from the list of available libraries, click Remove All.
   - To make a library available, click it in the list, and then click Select.
6. Select the default settings you want for the activity.
7. In the Activity Name box, type a name for the activity.
8. Select the folder where you want to save the activity:
   - Select Kidspiration Activities Folder to save the activity on the same computer where the Kidspiration program is installed. Click the category that you want the activity to appear under, for example “Science,” and then click Save Activity.
   - or-
   - Select Another Location to save the activity to a location other than the computer where the Kidspiration program is installed, for example a server. Click Save Activity. Navigate to the folder where you want to save the activity.
**Tip:** If you want specific symbols to be available for an activity, you can create a custom symbol library that contains the symbols you want, and then select the custom library as the Default Library for the activity.

**Note:** To distribute an activity with a custom symbol library to multiple computers, you must also copy the custom library file to the Kidspiration Libraries folder on these computers.

**See Also**
“Creating a new symbol library” on page 154.

**Sharing an activity with another computer**

There are two ways you can share an activity on your computer with multiple computers. You can use the Activity Wizard to save an activity to any location, for example on a network server, where other computers can access it. Or, you can copy the activity file to the Kidspiration Activities folder on another computer.

**To share an activity with another computer by copying the file:**

1. Open the Kidspiration Activities folder inside the Kidspiration 2 folder on the hard drive of your computer.
2. Copy the activity file to a network server or floppy disk.
3. Copy the activity file to the Kidspiration Activities folder on the other computer.

**Adding Internet hyperlinks to projects**

**Adding a hyperlink to a project**

You can add hyperlinks to ideas, notes, symbols and links. Hyperlinks are only active when URL Hyperlink Auto-detection is turned on in Application Options (click Application Options on the Teacher menu).
To add a hyperlink:

- Type the Internet address where you want the hyperlink to appear. For example:
  
  www.inspiration.com

After you add the hyperlink, when you move the mouse pointer over the link, the pointer looks like this \( \text{\textcircled{	extcolor{red}{H}}} \). This pointer indicates the hyperlink is active. Clicking the hyperlink starts the default browser and opens the site.

Adding a hyperlink to selected text

You can assign hyperlinks to selected text in ideas, notes, symbols and links. The hyperlinks are active in Picture View and Writing View. This allows you to create hyperlinks without long cryptic names, for example “Read about our science project” rather than “http://www.inspiration.com/science/amphibians/project.htm.”

To add a hyperlink to selected text:

1. Select the text to which you want to assign the hyperlink.
2. Enable the Teacher menu.
3. On the Teacher menu, click URL Hyperlink.
   
   The text you selected appears in the Hyperlink Text box. You can edit the text if you wish.
4. In the Hyperlink Address box, type the Internet address you want to assign to the text. For example:
   
   www.inspiration.com

Removing a hyperlink

- Select the hyperlink, and then click the Clear button.

–or–
1. Select the text to which the Internet address is assigned.
2. On the Teacher menu, click URL Hyperlink.
3. Click Remove Hyperlink.

**Changing the default look for projects**

You can customize the default settings for new projects. You can choose default settings for font, text size, text color and formatting. The default settings you choose for text apply to both Picture View and Writing View.

In Picture View, you can choose the default settings for the following: symbol library, symbol, symbol fill color, symbol line color and thickness, link arrow, link color, link thickness and symbol captions (show or hide).

In Writing View, you can choose the default settings for the following: lined paper (on or off), picture-to-topic (on or off), prefix and paper colors (background, horizontal lines and border). You can also choose options that control how a writing project appears when you transfer it to a word processor using the Publish tool.

**To change the default look for new projects:**

1. On the Teacher menu, click Save Default Settings.
2. Use the Default Settings Wizard to select the settings that you want.
3. When you are finished choosing default settings, click Finish.

New projects you start will use the settings that you selected.

**See Also**

“Sharing the default look for new projects with another computer” on page 143.
Sharing the default look for new projects with another computer

You can share the default look for new documents on your computer with multiple computers.

To share the default settings for new projects with another computer:

1. Open the Kidspiration Activities folder inside the Kidspiration 2 folder on the hard disk of your computer.
2. Copy the Default Settings file to a network server or floppy disk.
3. Copy the Default Settings file to the Kidspiration Activities folder on the other computer.

Setting Application Options

Turn the talking interface on or off

The talking interface reads all text in the Kidspiration interface, including all menus, buttons and dialog boxes. The talking interface is designed to help developing readers and writers use the software on their own.

To turn the talking interface on or off:

1. Enable the Teacher menu.
2. On the Teacher menu, click Application Options.
3. Select or clear the Talking Interface check box.
Turning the Listen tool on or off

The Listen tool reads the words in an idea or symbol.

**To turn the Listen tool on or off:**

1. Enable the **Teacher** menu.
2. On the **Teacher** menu, click **Application Options**.
3. Select or clear the **Listen tool** check box.

Turning sound recording on or off

The Record command lets you record a sound and attach it to a symbol or idea.

**To turn sound recording on or off:**

1. Enable the **Teacher** menu.
2. On the **Teacher** menu, click **Application Options**.
3. Select or clear the **Record Sounds** check box.

*Tip:* Turning off sound recording does not prevent students from playing sounds that have already been recorded. This allows a teacher to record instructions, and then turn off sound recording. Students can click the speaker icon to hear the teacher instructions, but cannot record their own sounds.

Turning animation on or off

Animated symbols can add a new dimension to your diagrams. A number of animated symbols are included in the symbol libraries. One example is the Traffic light symbol in the Basic library. You can also create your own animated symbols by inserting animated GIF files into the symbol libraries.
To turn animation on or off:
1. Enable the Teacher menu.
2. On the Teacher menu, click Application Options.
3. Select or clear the Animation Enabled check box.

See Also
“Inserting custom symbols and graphics into the symbol libraries” on page 148.

Showing or hiding the desktop
Kidspiration includes a “hidden desktop” feature. This hides the computer workspace behind Kidspiration to minimize distractions and prevent students from inadvertently leaving Kidspiration. In some cases, you may want the programs and files on the computer’s desktop to show when Kidspiration is running, for example if you are adding new symbols to the symbol libraries.

To show or hide the desktop running behind Kidspiration:
1. Enable the Teacher menu.
2. On the Teacher menu, click Application Options.
3. Select or clear the Hide Desktop check box.

Turning the spelling checker on or off
You can use the spelling checker to check your work.

To turn the spelling checker on or off:
1. Enable the Teacher menu.
2. On the Teacher menu, click Application Options.
3. Select or clear the Spell Check Enabled check box.
**Turning URL hyperlinks on or off**

URL hyperlinks are links to the Internet in a Kidspiration project. When you click a URL hyperlink, your web browser starts and opens the associated Internet address. You may not want hyperlinks to be active in some cases, for example when you are editing Internet addresses in a project or when you do not want a project to provide access to the Internet.

**To turn URL hyperlinks on or off:**

1. Enable the Teacher menu.
2. On the Teacher menu, click Application Options.
3. Select or clear the Live Hyperlinks check box.

**Automatically formatting Internet addresses as URL hyperlinks**

When you type an Internet address in a Kidspiration project, the address is automatically formatted as an URL hyperlink.

**To turn on or off automatic formatting of Internet addresses:**

1. Enable the Teacher menu.
2. On the Teacher menu, click Application Options.
3. Select or clear the URL Hyperlink Auto-detection check box.

**Turning picture-to-topic on or off**

Picture-to-topic translates pictorial symbol labels in Picture View to words in Writing View. This setting is designed for developing writers.

**To turn picture-to-topic on or off:**

- On the Teacher menu, click Picture-to-Topic.
  
  When picture-to-topic is on, a check mark appears next to the command.
Enabling or disabling the Teacher menu password

When the Teacher menu password is enabled, you must enter a password to access the commands on the Teacher menu.

To enable or disable the Teacher menu password:
1. Enable the Teacher menu.
2. On the Teacher menu, click Application Options.
3. Select or clear the Password Enabled check box.

See Also
“Setting a password for the Teacher menu” on page 135.

Selecting the preferred word processor

Kidspiration starts the preferred word processor when you use the Publish tool in Writing View.

To select the preferred word processor:
1. Enable the Teacher menu.
2. On the Teacher menu, click Application Options.
3. On the Preferred Word Processor menu, select Microsoft Word or AppleWorks, and then click OK.

See Also
“Publishing a project in a word processor” on page 157.

Working with the symbol libraries

Teachers have complete control of the Kidspiration symbol libraries. It is easy to add, change or remove symbols to meet the needs of your classroom. Often you may wish to create a custom symbol library for use with a particular classroom activity you are creating.
Inserting custom symbols and graphics into the symbol libraries

You can insert custom symbols and graphics into the symbol libraries so they are available for use on a regular basis. There are several ways to insert graphics into the symbol libraries:

- Inserting a symbol or graphic on a diagram into a symbol library
- Inserting a graphics file into a symbol library
- Copying and pasting a graphic into a symbol library

See Also
“Creating a new symbol library” on page 154.

Inserting a symbol or graphic on a diagram into a symbol library

1. On your diagram, select the symbol or graphic you want to insert into a symbol library.
2. On the Symbol palette, display the library to which you want to add the symbol.
   There must be an open slot at the bottom of the library in order to insert the symbol. If there are no open slots in the library, Kidspiration places the symbol in the Custom category.
3. Enable the Teacher menu.
4. On the Teacher menu, click Install User Symbol.
5. Select the size you want the symbol to be, and then click OK.
   - Select Standard Symbol Size to size the symbol equivalent to the other Kidspiration symbols.
   - Select Actual Size to retain the original size of the graphic.

When your symbol is installed, it appears at the bottom of the symbol library entries. It is now ready for your use.

See Also
“Inserting a graphics file into a symbol library” on page 149.
“Creating a new symbol library” on page 154.
Inserting a graphics file into a symbol library

You can insert graphics files into the symbol libraries so the graphics are available as symbols. On the Macintosh, you can insert PICT, JPEG and GIF files. In Windows, you can insert WMF, BMP, JPEG and GIF files.

To insert a graphics file into a symbol library:

1. Enable the Teacher menu.
   The Edit Symbol Libraries dialog box appears.
3. On the left list, select the library to which you want to add the graphic.
   There must be an open slot at the bottom of the library in order to add the symbol. If there are no open slots in the library, Kidspiration creates a new library called User 1 under the Custom category. When no slots are available in User 1, Kidspiration creates a User 2 library and so on.
4. Click Import Graphic.
5. Select the graphic you want to install, and then click Open.
6. Select the size you want the symbol to be, and then click OK.
   • Select Standard Symbol Size to size the symbol equivalent to the other Kidspiration symbols.
   –or–
   • Select Actual Size to retain the original size of the graphic.
7. In the Label box, type a name for the symbol.
   When your symbol is installed, it appears in the first available slot in the symbol library entries. It is now ready for your use.

Tip: You can also drag and drop a graphics file into a symbol library. On the Macintosh, you can drag and drop PICT, JPEG and GIF files. In Windows, you can drag and drop WMF, BMP, JPEG and GIF files. On the Symbol palette, display the library to which you want to insert the graphic, and then drag the file to the Symbol palette. If there is no available slot for the graphic, Kidspiration places the graphic in the Custom category as described above. Turn off Hide Desktop in Application Options.
(click Application Options on the Teacher menu) before you drag and drop a graphics file.

**See Also**

“Creating a new symbol library” on page 154.

**Copying and pasting a graphic into a symbol library**

You can copy and paste graphics from other programs into the symbol libraries so the graphics are available as symbols.

**To copy and paste a graphic into a symbol library:**

1. Copy the graphic.
2. In Kidspiration, enable the Teacher menu.
4. On the left list, select the library to which you want to insert the graphic.
   - There must be an open slot at the bottom of the library. If there are no open slots, Kidspiration creates a new library called User 1 under the Custom category. When no slots are available in User 1, Kidspiration creates a User 2 library and so on.
5. Click Paste Graphic.
6. Select the size you want the symbol to be, and then click OK.
   - Select **Standard Symbol Size** to size the symbol equivalent to the other Kidspiration symbols.
   - or—
   - Select **Actual Size** to retain the original size of the graphic.
7. In the Label box, type a name for the symbol.

When your symbol is installed, it appears in the first available slot in the symbol library. It is now ready for your use.
Copying a symbol from one library to another

You can copy symbols from one library to another. The library you copy the symbol to must have an available slot for the symbol. Copying symbols is useful when you want to create a symbol library with symbols you use frequently.

To copy a symbol from one library to another:

   The Edit Symbol Libraries dialog box appears.
2. On the left list, select the library that contains the symbol you want to copy.
3. On the right list, select the library to which you want to copy the symbol.
4. Select the symbol you want to copy, and then drag it to the location where you want it in the other library.
   A copy of the symbol appears in its new location.
5. In the Label box, type a name for the symbol.
6. Do one of the following:
   • To apply your changes, click OK.
   –or–
   • To cancel your changes, click Cancel.

Tip: You can also change the order of symbols within a library. Drag a symbol to move it to a new location. The other symbols are automatically rearranged.

Deleting a symbol from a library

When you delete a symbol from a library, it is no longer available to use in projects.

To delete a symbol from a library:

   The Edit Symbol Libraries dialog box appears.
2. On either the left or right list, select the library that contains the symbol you want to delete.
   A symbol cannot be deleted if it appears in a project that is open.

3. Drag the symbol to the Trash icon.

4. Do one of the following:
   • To apply your changes, click OK.
     —or—
   • To cancel your changes, click Cancel.

**Changing the order of symbols in a symbol library**

You can change the order of symbols in a symbol library.

**To change the order of symbols in a library:**

   The Edit Symbol Libraries dialog box appears.

2. On the left list, select the library for which you want to change the order of the symbols.

3. Select a symbol you want to move, and then drag it to the new location.
   The other symbols are automatically rearranged.

4. Move as many symbols as you wish.

5. Do one of the following:
   • To apply your changes, click OK.
     —or—
   • To cancel your changes, click Cancel.
Creating a new symbol category

When you create a new symbol library, it is automatically stored in the Custom category on the Symbol palette unless you specify a different category. You can create your own symbol categories to store the symbol libraries you create or libraries that you copy.

To create a new symbol category:

1. On the File menu, click Quit (Macintosh) or Exit (Windows) to quit Kidspiration.
2. On the computer, open the Kidspiration Libraries folder inside the Kidspiration 2 folder.
3. Create a new folder inside the Kidspiration Libraries folder. Name the folder the same name as the category you want to appear on the Symbol palette. For example, if you want a category called “Student Symbols,” then name the folder “Student Symbols.”

   Tip: You can renumber the folders in the Kidspiration Libraries folder to change the order of the categories on the Symbol palette.

4. Copy the symbol libraries you want to appear in your new category into this folder.

   Note: To appear on the list of libraries, the new category must contain at least one symbol library. For this reason, it may be helpful to create your symbol libraries first, and then create the new category.

5. Start Kidspiration.

   The new category appears at the bottom of the list of categories on the Symbol palette. You can now place symbol libraries in the new category.

See Also

“Inserting custom symbols and graphics into the symbol libraries” on page 148.

“Creating a new symbol library” on page 154.

“Copying a symbol library” on page 154.
Creating a new symbol library

You can create new symbol libraries for symbols you import, create or copy from other libraries. For example, you might want to create a new symbol library for the symbols you use frequently or for an activity you create. You can place a new symbol library under any category on the Symbol palette. If you do not choose a category, the symbol library is automatically stored in the Custom category.

To create a new symbol library:

1. Enable the Teacher menu.
2. On the Teacher menu, click New Symbol Library.
3. In the Category list, select the category you want the new library to appear under on the Symbol palette.
4. In the Library box, type a name for the new library.

See Also

“Inserting custom symbols and graphics into the symbol libraries” on page 148.

“Creating a new symbol category” on page 153.

Copying a symbol library

You may want to copy the custom symbol libraries you create so you can make them available to other computers. Each symbol library is a file with an INL extension that is stored in the Kidspiration Libraries folder inside the Kidspiration 2 folder.

To copy a symbol library:

1. Open the Kidspiration 2 folder on your computer.
2. Double-click the Kidspiration Libraries folder to open it.
3. Double-click the folder that contains the symbol library.
   The name of the folder is the Category name that the library appears under on the Symbol palette, for example “Custom.”
4. Select the symbol library file.
5. Copy the file.
Sharing a symbol library with another computer

You can share a custom symbol library with another computer running Kidspiration by copying the symbol library file to a floppy disk (or network server), and then copying the file to the Kidspiration Libraries folder inside the Kidspiration folder on the other computer.

To share a symbol library with another computer:

1. Copy the symbol library file to a floppy disk or network server.
2. Insert the floppy disk in the computer with which you want to share the symbol library or connect to the network server.
3. On the computer, open the Kidspiration Libraries folder inside the Kidspiration 2 folder.
4. Select the symbol category under which you want the library to appear (for example, “Custom”), and then open the folder.
5. Copy the symbol library file from the floppy disk or network server to the category folder.

Tip: You can share Inspiration symbol libraries with Kidspiration.

See Also
“Copying a symbol library” on page 154.
Using Kidspiration projects with other programs

Opening a document created in another program

Kidspiration can open the following types of documents:

- Kidspiration 1 and later (Macintosh or Windows)
  In Windows, Kidspiration files must have the .kid extension.
- Inspiration 7 and later (Macintosh or Windows)
  In Windows, Inspiration files must have the .isf extension. When you open an Inspiration document in Kidspiration, you may lose some elements and formatting in the document.

See Also
“Opening an Inspiration document” on page 157.

To open a document created in another program:

1. On the File menu, click Open.
   The Open dialog box appears. Kidspiration shows you the names of any files that can be opened.
2. Select the folder where the file is located.
3. Click the file you want to open in the list, and then click Open.
   If you are using Windows, you can specify the type of file you want to open. On the Files of Type list, select the file type.
   Here are your choices:
   - Kidspiration (.kid) opens other Kidspiration documents.
   - Inspiration (.isf) opens Inspiration documents.
Opening an Inspiration document

Kidspiration 2 can open documents created in Inspiration 7 and later versions of Inspiration. When you open an Inspiration document, you may lose elements and formatting in the document.

Note: You cannot open an Inspiration document with more than ten levels of topics.

To open an Inspiration document:

1. On the File menu, click Open.
2. In the Open dialog box, navigate to the Inspiration file, and then click Open.

The Inspiration document opens as an untitled document.

Publishing a project in a word processor

You can use the Publish tool to transfer a project in Writing View to Microsoft Word or AppleWorks. You can control how projects are published using the publish options (click Publish Options on the Teacher menu). You can also set publish options when you choose default settings for a project and when you save a project as an activity.

In the word processing document, ideas and notes text appear on separate lines with no indentation. Ideas are the text size of the Writing View default font with bold formatting. Notes are the text size of the Writing View default font. A blank line appears between each note card.

To publish a project in a word processor:

- On the Formatting toolbar, click the Publish button.
The Kidspiration project is transferred to the word processing document. The preferred word processor starts and opens the document.

The word processing document is saved in one of the following locations:

- If you save the Kidspiration project before you publish it, the word processing document is saved in the same folder as the Kidspiration project.
  –or–
- If you do not save the Kidspiration project before you publish it, the word processing document is saved in the user Documents folder (Mac OS X), the root Documents folder (Mac OS 9) or My Documents folder (Windows).

See Also
“Creating an activity” on page 137.
“Changing the default look for projects” on page 142.
“Selecting the preferred word processor” on page 147.

Setting publish options
You can control how projects are published using the Publish Options on the Teacher menu.

Note: You can set the publish options for an activity using the Activity Wizard. For more information, see “Creating an activity” on page 137.

To set publish options:
1. On the Teacher menu, click Publish Options.
2. To include a graphic of the diagram in the word processing document, select the Diagram check box.
3. On the Writing menu, select the text to include in the word processing document:
   - Select Only Notes to include only the notes in the Kidspiration writing project.
   –or–
• Select **Topics and Notes** to include both the topics and notes in the Kidspiration writing project.

A preview of the word processing document appears on the right side of the dialog box.

4. After you select the options, click **OK**.

**Saving projects in other file formats**

You can save Kidspiration projects in a variety of file formats that can be opened in other programs. To find out which file format you can use with another program, refer to the documentation that came with the program.

**In Picture View, you can save a diagram in the following file formats:**

• **BMP (Windows)**—Saves a diagram in the standard Microsoft Windows graphic bitmap format (BMP).

• **PICT (Macintosh)**—Saves a diagram as a PICT or PICT2 file that can be opened in graphics, presentation and page layout programs.

• **JPEG**—Saves the diagram as a graphic that can be opened in graphics, presentation and page layout programs or Web pages.

• **GIF**—Saves the diagram as a 256 color graphic that can be opened in graphics, presentation and page layout programs or Web pages.

• **HTML**—Saves a diagram as an HTML document, which can be viewed on the Internet. The diagram shrinks so that it fits on a 640-pixel-wide screen. The height is adjusted proportionally. Any hyperlinks in the diagram are included as hyperlinks in the HTML document. This export makes two files: an HTM file and GIF file. Both files need to remain together to view the HTML file in a browser.
In Writing View, you can save a project in the following file formats:

- **Plain Text**—Saves a writing project as an unformatted text-only document with outline levels.
- **AppleWorks (RTF)**—Saves a writing project as a formatted document that can be opened in AppleWorks.
- **Microsoft Word (RTF)**—Saves a writing project as a formatted document that can be opened in Microsoft Word. When you open the document in Word, a dialog box may appear, asking if you want to convert the RTF data. Click Yes to open the formatted document.
- **HTML**—Saves a writing project as a one-page HTML document, which can be opened by an Internet browser. When you save a writing project as a one-page HTML document, the text entered into the Student Name dialog box becomes the title of the HTML document. The title of the page appears in large type at the top of the page. Ideas and notes appear as the body of the document. At the end of the page, a “Back to Top” link appears. When you click “Back to Top,” you return to the top of the page. Any hyperlinks in the writing project are retained in the HTML document.

Saving a project in Kidspiration 1 format

You can save Kidspiration 2 projects and activities in Kidspiration 1 format so you can open them using Kidspiration 1. When you save as a Kidspiration 1 document, you may lose elements and formatting in the document.

**To save a project in Kidspiration 1 format:**

1. On the **File** menu, click **Save**.
2. On the **Format** menu, click **Kidspiration 1 document**, and then click **Save**.
3. To make an activity available to Kidspiration 1, move the activity file into the Kidspiration 1 **Activities** folder.
Saving a diagram as a graphic

1. Open the diagram.
2. On the File menu, click Export.
3. Select the file format you want, and then click Save.
4. Select the folder where you want to save the file.
5. Type a name for the file.
   Kidspiration automatically uses the text entered into the Student Name dialog box as the name and assigns the appropriate extension. You can change the name of the file if you want.
6. Click Save.

See Also
“Adding your name to a project” on page 17.
“Saving projects in other file formats” on page 159.

Saving a diagram as an HTML document

You can save a diagram as a one-page HTML document, which can be opened by an Internet browser.

To save a diagram as an HTML document:

1. Open the diagram.
2. On the File menu, click Export.
3. Select HTML, and then click Save.
4. Select the folder where you want to save the document.
5. Type a name for the document.
   Kidspiration automatically uses the text entered into the Student Name dialog box as the name and assigns the appropriate extension. You can change the name of the file if you want.
6. Click **Save**.

The HTML export makes two files: an HTM file and a GIF file. The GIF file appears in the same location as the HTM file. Both files need to remain together to view the HTM file in a browser.

**See Also**

“Adding your name to a project” on page 17.

**Saving a writing project as an HTML document**

You can save a project in Writing View as a one-page HTML document, which can be opened by an Internet browser.

When you save a writing project as a one-page HTML document, the text entered into the Student Name dialog box becomes the title of the HTML document. The title of the page appears in large type at the top of the page. Ideas and notes appear as the body of the document. At the end of the page, a “Back to Top” link appears. When you click “Back to Top,” you return to the top of the page. Any hyperlinks in the writing project are retained in the HTML document.

**To save a writing project as an HTML document:**

1. Open the writing project.
2. On the **File** menu, click **Export**.
3. Select **HTML**, and then click **Save**.
4. Select the folder where you want to save the document.
5. Type a name for the document.

   Kidspiration automatically uses the text entered into the Student Name dialog box as the name and assigns the appropriate extension. You can change the name of the file if you want.
6. Click **Save**.
Saving a writing project as a text file

You can save a writing project as a text file, which can be opened by a text editor or word processing program.

To save a writing project as a text file:

1. Open the project.
2. On the File menu, click Export.
3. Select Plain Text, AppleWorks or Microsoft Word, and then click Save.
4. Select the folder where you want to save the document.
5. Type a name for the document.
6. Click Save.

Note: When you open the document in Microsoft Word, a dialog box may appear asking if you want to convert the RTF data. Click Yes to open the formatted document.

See Also

“Publishing a project in a word processor” on page 157.
Chapter 11: Accessibility

Accessibility for people with disabilities

Inspiration Software is committed to making products that everyone can use. Kidspiration provides features to help people with disabilities use the software successfully.

- You can magnify a diagram to make text and symbols appear larger on the screen. For more information, see “Magnifying or reducing the view of a diagram” on page 104.
- You can make the default text size larger. For more information, see “Changing the default look for projects” on page 142.
- You can change the default colors for symbols, text and the lined paper. For more information see “Changing the default look for projects” on page 142.
- You can use the keyboard to do many tasks. For more information, see “Using keyboard shortcuts” on page 165.
- You can use the talking interface to read the text in menus, toolbars and dialog boxes. For more information, see “Turn the talking interface on or off” on page 143.
- You can use the Listen tool to read the text in a document. For more information, see “Listening to the text in a project” on page 128.

Using keyboard shortcuts

Kidspiration provides many keyboard shortcuts that can save you time and make it easier to edit projects in Picture View or Writing View. There are keyboard shortcuts for many Kidspiration commands, including:
Shortcuts for common commands such as opening and saving projects

<table>
<thead>
<tr>
<th>To:</th>
<th>Macintosh</th>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open new document</td>
<td>Command+N</td>
<td>Ctrl+N</td>
</tr>
<tr>
<td>Open existing document</td>
<td>Command+O</td>
<td>Ctrl+O</td>
</tr>
<tr>
<td>Save open document</td>
<td>Command+S</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Print open document</td>
<td>Command+P</td>
<td>Ctrl+P</td>
</tr>
<tr>
<td>Quit/Exit Kidspiration</td>
<td>Command+Q</td>
<td>Ctrl+Q</td>
</tr>
<tr>
<td>Add student name</td>
<td>Command+J</td>
<td>Ctrl+J</td>
</tr>
<tr>
<td>Cut</td>
<td>Command+X</td>
<td>Ctrl+X</td>
</tr>
<tr>
<td>Copy</td>
<td>Command+C</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Paste</td>
<td>Command+V</td>
<td>Ctrl+V</td>
</tr>
<tr>
<td>Undo/Redo</td>
<td>Command+Z</td>
<td>Ctrl+Z</td>
</tr>
<tr>
<td>Clear</td>
<td>Delete</td>
<td>Delete or Backspace</td>
</tr>
<tr>
<td>Help</td>
<td>F1</td>
<td>F1</td>
</tr>
<tr>
<td>Spell check</td>
<td>F7</td>
<td>F7</td>
</tr>
<tr>
<td>Insert Hyperlink</td>
<td>F6</td>
<td>F6</td>
</tr>
</tbody>
</table>

Shortcuts for changing the view

<table>
<thead>
<tr>
<th>To:</th>
<th>Macintosh</th>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fit to Window</td>
<td>Command+E</td>
<td>Ctrl+E</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Command+(-)</td>
<td>Ctrl+(-)</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Command+(=)</td>
<td>Ctrl+(=)</td>
</tr>
<tr>
<td>Zoom to 200%</td>
<td>Command+0</td>
<td>Ctrl+0</td>
</tr>
<tr>
<td>Switch to Writing View</td>
<td>Command+T</td>
<td>Ctrl+T</td>
</tr>
<tr>
<td>Switch to Picture View</td>
<td>Command+T</td>
<td>Ctrl+T</td>
</tr>
<tr>
<td>Hide Kidspiration (Mac OS X only)</td>
<td>Command+H</td>
<td>NA</td>
</tr>
</tbody>
</table>
**Shortcuts for navigating in Picture View**

<table>
<thead>
<tr>
<th>To:</th>
<th>Macintosh</th>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to the first symbol</td>
<td>Home</td>
<td>Home</td>
</tr>
</tbody>
</table>

**Shortcuts for navigating in Writing View**

<table>
<thead>
<tr>
<th>To:</th>
<th>Macintosh</th>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to the first idea</td>
<td>Home</td>
<td>Home</td>
</tr>
<tr>
<td>Go to the last idea</td>
<td>End</td>
<td>End</td>
</tr>
</tbody>
</table>

**Shortcuts for moving between symbol libraries**

<table>
<thead>
<tr>
<th>To:</th>
<th>Macintosh</th>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Previous Library</td>
<td>Command+(,)</td>
<td>Ctrl+(,)</td>
</tr>
<tr>
<td>Next Library</td>
<td>Command+(,)</td>
<td>Ctrl+(,)</td>
</tr>
</tbody>
</table>
### Shortcuts for adding symbols

<table>
<thead>
<tr>
<th>To:</th>
<th>Macintosh</th>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Symbol Maker tool</td>
<td>Command+M</td>
<td>Ctrl+M</td>
</tr>
<tr>
<td>Add SuperGrouper shape</td>
<td>Command+K</td>
<td>Ctrl+K</td>
</tr>
<tr>
<td>Add oval symbol</td>
<td>Command+1</td>
<td>Ctrl+1</td>
</tr>
<tr>
<td>Add rectangle symbol</td>
<td>Command+2</td>
<td>Ctrl+2</td>
</tr>
<tr>
<td>Add text only symbol</td>
<td>Command+3</td>
<td>Ctrl+3</td>
</tr>
<tr>
<td>Add rounded rectangle symbol</td>
<td>Command+4</td>
<td>Ctrl+4</td>
</tr>
<tr>
<td>Add first symbol shape from palette</td>
<td>Shift+F1</td>
<td>Shift+F1</td>
</tr>
<tr>
<td>Add second symbol shape from palette</td>
<td>Shift+F2</td>
<td>Shift+F2</td>
</tr>
<tr>
<td>Add third symbol shape from palette</td>
<td>Shift+F3</td>
<td>Shift+F3</td>
</tr>
<tr>
<td>Add fourth symbol shape from palette</td>
<td>Shift+F4</td>
<td>Shift+F4</td>
</tr>
<tr>
<td>Add fifth symbol shape from palette</td>
<td>Shift+F5</td>
<td>Shift+F5</td>
</tr>
<tr>
<td>Add sixth symbol shape from palette</td>
<td>Shift+F6</td>
<td>Shift+F6</td>
</tr>
<tr>
<td>Add seventh symbol shape from palette</td>
<td>Shift+F7</td>
<td>Shift+F7</td>
</tr>
<tr>
<td>Add eighth symbol shape from palette</td>
<td>Shift+F8</td>
<td>Shift+F8</td>
</tr>
<tr>
<td>Add ninth symbol shape from palette</td>
<td>Shift+F9</td>
<td>Shift+F9</td>
</tr>
<tr>
<td>Add new linked symbol to the left</td>
<td>Command+Left Arrow</td>
<td>Ctrl+Left Arrow</td>
</tr>
<tr>
<td>Add new linked symbol to the right</td>
<td>Command+Right Arrow</td>
<td>Ctrl+Right Arrow</td>
</tr>
<tr>
<td>Add new linked symbol up</td>
<td>Command+Up Arrow</td>
<td>Ctrl+Up Arrow</td>
</tr>
<tr>
<td>Add new linked symbol down</td>
<td>Command+Down Arrow</td>
<td>Ctrl+Down Arrow</td>
</tr>
</tbody>
</table>
### Shortcuts for adding links

<table>
<thead>
<tr>
<th>To:</th>
<th>Macintosh</th>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turn Link tool on or off</td>
<td>Command+\</td>
<td>Ctrl+\</td>
</tr>
<tr>
<td>Extend link right</td>
<td>Right Arrow</td>
<td>Right Arrow</td>
</tr>
<tr>
<td>Extend link left</td>
<td>Left Arrow</td>
<td>Left Arrow</td>
</tr>
<tr>
<td>Extend link up</td>
<td>Up Arrow</td>
<td>Up Arrow</td>
</tr>
<tr>
<td>Extend link down</td>
<td>Down Arrow</td>
<td>Down Arrow</td>
</tr>
<tr>
<td>Select origin or target symbol</td>
<td>Return or 10-key Enter</td>
<td>Enter or 10-key Enter</td>
</tr>
</tbody>
</table>

### Shortcuts for selecting and moving symbols

<table>
<thead>
<tr>
<th>To:</th>
<th>Macintosh</th>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select first main idea</td>
<td>Home</td>
<td>Home</td>
</tr>
<tr>
<td>Nudge symbol right</td>
<td>Shift+Right Arrow</td>
<td>Shift+Right Arrow</td>
</tr>
<tr>
<td>Nudge symbol left</td>
<td>Shift+Left Arrow</td>
<td>Shift+Left Arrow</td>
</tr>
<tr>
<td>Nudge symbol up</td>
<td>Shift+Up Arrow</td>
<td>Shift+Up Arrow</td>
</tr>
<tr>
<td>Nudge symbol down</td>
<td>Shift+Down Arrow</td>
<td>Shift+Down Arrow</td>
</tr>
</tbody>
</table>

### Shortcuts for adding ideas in Writing View

<table>
<thead>
<tr>
<th>To:</th>
<th>Macintosh</th>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add topic</td>
<td>Command+G</td>
<td>Ctrl+G</td>
</tr>
</tbody>
</table>

### Shortcuts for selecting and moving ideas in Writing View

<table>
<thead>
<tr>
<th>To:</th>
<th>Macintosh</th>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select first idea</td>
<td>Home</td>
<td>Home</td>
</tr>
<tr>
<td>Select last idea</td>
<td>End</td>
<td>End</td>
</tr>
<tr>
<td>Select next idea up in hierarchy</td>
<td>Command+Up Arrow</td>
<td>Ctrl+Up Arrow</td>
</tr>
<tr>
<td>Select next idea down in hierarchy</td>
<td>Command+Down Arrow</td>
<td>Ctrl+Down Arrow</td>
</tr>
<tr>
<td>Move idea left</td>
<td>Command+L</td>
<td>Ctrl+L</td>
</tr>
<tr>
<td>Move idea right</td>
<td>Command+R</td>
<td>Ctrl+R</td>
</tr>
<tr>
<td>Flip idea down</td>
<td>Command+/</td>
<td>Ctrl+/&gt;</td>
</tr>
<tr>
<td>Flip idea up</td>
<td>Command+(')</td>
<td>Ctrl+(')</td>
</tr>
</tbody>
</table>
### Shortcuts for editing and formatting text

<table>
<thead>
<tr>
<th>To:</th>
<th>Macintosh</th>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extend selection to beginning of line</td>
<td>Shift+Home</td>
<td>Shift+Home</td>
</tr>
<tr>
<td>Extend selection to end of line</td>
<td>Shift+End</td>
<td>Shift+End</td>
</tr>
<tr>
<td>Extend selection left one character</td>
<td>Shift+Left Arrow</td>
<td>Shift+Left Arrow</td>
</tr>
<tr>
<td>Extend selection right one character</td>
<td>Shift+Right Arrow</td>
<td>Shift+Right Arrow</td>
</tr>
<tr>
<td>Bold</td>
<td>Command+B</td>
<td>Ctrl+B</td>
</tr>
<tr>
<td>Italics</td>
<td>Command+I</td>
<td>Ctrl+I</td>
</tr>
<tr>
<td>Underline</td>
<td>Command+U</td>
<td>Ctrl+U</td>
</tr>
<tr>
<td>Increase text size</td>
<td>Shift+Command+(.)</td>
<td>Shift+Ctrl+(.)</td>
</tr>
<tr>
<td>Decrease text size</td>
<td>Shift+Command+(,.)</td>
<td>Shift+Ctrl+(,.)</td>
</tr>
<tr>
<td>Add a new line of text</td>
<td>Return or 10-key Enter</td>
<td>Enter or 10-key Enter</td>
</tr>
<tr>
<td>End text editing and select the idea or symbol</td>
<td>Shift+Return or Shift+10-key Enter</td>
<td>Shift+Enter or Shift+10-key Enter</td>
</tr>
<tr>
<td>Spell check</td>
<td>F7</td>
<td>F7</td>
</tr>
<tr>
<td>Insert Hyperlink</td>
<td>F6</td>
<td>F6</td>
</tr>
</tbody>
</table>

### Shortcuts for using audio features

<table>
<thead>
<tr>
<th>To:</th>
<th>Macintosh</th>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turn Listen tool on or off</td>
<td>Shift+Command+D</td>
<td>Shift+Ctrl+D</td>
</tr>
<tr>
<td>Read text in selection</td>
<td>Command+D</td>
<td>Ctrl+D</td>
</tr>
</tbody>
</table>
Inspiration Software, Inc. License Agreement

IMPORTANT—PLEASE READ THIS LICENSE AGREEMENT CAREFULLY BEFORE OPENING THE SOFTWARE PACKAGE: By opening this Software package (package containing the CD), you agree to be bound by the terms and conditions of this Agreement. If you do not agree with these terms, promptly return the unopened Software package, along with the rest of the package, to the place of purchase for a full refund.

This is a legal agreement between you, the end user, and Inspiration Software, Inc. The enclosed computer program (“Software”) is licensed, not sold, to you by Inspiration Software, Inc. for use under the terms of this license.

GRANT OF LICENSE: Inspiration Software, Inc. grants you the following rights to the Software:

Single installation: You may install and use the Software on the temporary memory or hard drive or other storage device of any single computer used by one person at a time. You must license (purchase) an additional copy of the Software for each additional computer on which you want to use it. You must also license (purchase) additional copies of the software if the single computer is being used in a server-based computing environment, which allows multiple, concurrent users to run a single server.

Multiple licenses: If you have multiple Licenses of the Software, then at any time you may have as many computers with the Software installed as you have Licenses. You must license (purchase) an additional copy of the Software for each additional computer on which you want to use it.

Ownership: You admit and agree to the validity and enforceability in all respects of any copyright of Inspiration Software, Inc. You agree that you will not participate in any attack on the validity or enforceability of any of the present copyrights, or potential future copyrights of Inspiration Software, Inc. whether in court, the United States Copyright Office, or elsewhere except as may be required in response to a subpoena. All rights to the Software (including but not limited to any images, photographs, animations, video, audio, music, text, examples, templates, symbols and software modules incorporated into the Software) are owned or licensed by Inspiration Software, Inc. and are protected by the United States and International copyright laws and International trade provisions.

OTHER RESTRICTIONS: You may not:

a) Reverse-engineer, disassemble, decompile, modify or create derivative works of this software.

b) Sublicense, rent, loan or lease any portion of the Software or accompanying materials.

c) Use the backup or archival copies of the Software (or allow someone else to use such copies) for any purpose other than backup.

You may transfer the Software and the accompanying written materials to a recipient provided you retain no copies and the recipient agrees to the terms of this Agreement.

LIMITED WARRANTY: Inspiration Software, Inc. warrants that the media on which the Software is recorded will be free of defects in materials and workmanship under normal use for 90 days after the date of original purchase. If a defect occurs during the 90-day
period, you may return the media (disks or CD) to Inspiration Software, Inc. for free replacement. Inspiration Software, Inc. will replace the media, provided that you have previously returned the product registration card accompanying the Software to Inspiration Software, Inc. Any replacement Software will be warranted for the remainder of the original warranty period or 30 days, whichever is greater. These remedies are not available outside of the United States of America.

Inspiration Software, Inc. disclaims all other warranties, either express or implied, including but not limited to implied warranties of merchantability and fitness for a particular purpose, with respect to the product. This limited warranty gives you certain legal rights. You may have others, which vary from state to state. In no event will Inspiration Software, Inc. be liable to you for damages, whether based on contract, tort, warranty or other legal or equitable grounds, including any loss of profits, cost savings or other incidental or consequential damages arising out of your use or inability to use the Software, even if Inspiration Software, Inc. or an authorized representative of Inspiration Software, Inc. has been advised of the possibility of such damage. Inspiration Software, Inc. does not warranty that the Software will meet your requirements or that the operation of the Software will be uninterrupted or error-free.

**GENERAL:** This License will be construed under the laws of Oregon, except for that body of law dealing with conflicts of law. If there is any dispute under the present agreement, you consent to the jurisdiction and venue of all state and federal courts of Oregon. If any provision of this License shall be held by a court of competent jurisdiction to be contrary to law, that provision will be enforced to the maximum extent permissible, and the remaining provisions of this License will remain in full force and effect. If you are a U.S. Government user, then the Software is provided with “RESTRICTED RIGHTS” as set forth in the sub paragraphs c(1) and (2) of the Commercial Computer Software-Restricted Rights clause at FAR 52.277-19 or subparagraph c(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.277-7013, as applicable.
Index

A
accessibility 165
activities 136
  creating 73, 137
  opening 66
  sharing with other computers 140
Activity Guide 12
Add Idea tool 107
Add Symbol tool 76
adding
  custom symbols to libraries 148
  hyperlinks 67, 140
  hyperlinks to selected text 141
  ideas in Writing View 48, 107
  links 42
  name to document 17, 30
  page numbers 131
SuperGrouper categories 58
symbols
  Add Symbol tool 31, 32, 76
  point and type 76
  SuperGrouper categories 98
  Symbol palette 76, 98
Adobe Reader 12
aligning symbols 81
animated symbols 144
AppleWorks 55
Application Options
  animated symbols 144
  desktop 145
  Listen tool 144
  preferred word processor 147
  sound recording 144
  spelling checker 145
  talking interface 143
  Teacher menu password 147
  URL hyperlink auto-detection 146
  URL hyperlinks 146
arrowhead style 118
audio
  erasing recorded sounds 130
  Listen tool 70, 128
  playing recorded sounds 72, 130
reading text in Kidspiration
  interface 128
  reading text in symbols and ideas 128
  recording sounds 71, 128
  turning sound recording on or off 144
  turning the Listen tool on or off 144
  turning the talking interface on or off 143
B
BMP files
  inserting into diagram 103
  saving diagrams as BMP files 159
bold formatting 52, 114
C
captions
  showing and hiding 33, 77
categorizing ideas 96
changing the view
  fitting diagram in window 104
  magnifying or reducing 104
checking spelling 124
Circle tool 87
Clear All tool 35, 91, 93
Clear tool 43, 62
  Picture View 101
  Writing View 110
clearing canvas in Symbol Maker 35, 91
closing
  documents 45, 56, 65
  Kidspiration 15
colors
  background 119, 120
  lined paper 120
  links 119
  reverting to original symbol colors 116
SuperGrouper shapes 61, 116
symbols 116
text 115
copying
  symbol libraries 154
  symbols from library to library 151
copying and pasting
graphics into symbol libraries 150
ideas 110, 111
symbols 103
text 124
using Symbol Maker tools 91
creating
activities 73, 137
diagrams 75
password 67
SuperGrouper shapes 59, 98
symbol categories 153
symbol libraries 154
Teacher symbols 69
Web pages in Picture View 161
Web pages in Writing View 162
custom symbols
adding to symbol libraries 148
drawing 82
customer service 11
cutting and pasting
ideas 111
symbols 102, 103
text 124
using Symbol Maker tools 91
dictionary 125
dispersing
animated symbols 144
Listen tool 144
sound recording 144
spelling checker 145
talking interface 143
Teacher menu password 147
URL hyperlink auto-detection 146
URL hyperlinks 146
documentation 2, 12
documents
closing 45, 56, 65
default look 142
Inspiration 157
opening 17, 46
printing 72, 131
saving 18, 30, 54, 58
saving in other file formats 159
starting 15
starting new diagram 75
starting new writing project 105
drawing
erasing part of 35, 92
drawing lines
Symbol Maker tool 85
drawing shapes
Symbol Maker tool 87
drawing symbols 34–39, 82
dashes links 118
default look
new documents 142
sharing with other computers 143
deleting
hyperlinks 141
ideas 110
links 102
part of diagram 43
symbols 101
symbols and links 102
symbols from libraries 151
desktop
showing or hiding 145
details
adding to ideas 51, 107
diagrams
opening 17
removing part 43
saving as graphics 161
saving as HTML documents 161
starting 29, 57, 75
earlier versions 7
opening a Kidspiration 1 document 156
saving a document in Kidspiration 1
format 160
editing text
ideas 123
symbols 123
editing user dictionary 125
enabling
animated symbols 144
Listen tool 144
picture-to-topic 146
sound recording 144
spelling checker 145
talking interface 143
Teacher menu 67, 135
Teacher menu password 147
URL menu password 146
URL hyperlinks 146
Eraser tool 36, 92
erasing
  part of drawing 35, 92
  recorded sounds 130
even spacing 81
exiting Kidspiration 15
exporting
  documents 159
  documents to word processor 55, 157

F
file name 18
files
  closing 15, 56
  opening 17, 46
  saving 18
  saving in Kidspiration format 160
  saving in other file formats 159
fill
  Symbol Maker tool 91
fitting diagram in window 104
fixing mistakes 43
font 44, 113
Font box 44
formatting Internet addresses 146
formatting links
  arrowhead style 119
  color 119
  dashed 118
  width 118
formatting pages
  background color 119, 120
  lined paper colors 120
  prefix style 120
formatting SuperGrouper shapes
  color 116
  line width 115
  size 117
formatting symbols
  color 116
  line width 115
  size 117
formatting text 43–44, 52
  bold 114
  color 114
  font 113
  italics 114
  shortcuts 170
text size 113
underline 114
Formatting toolbar
  Picture View 22
  Writing View 26

G
GIF files
  inserting into diagram 103
  saving diagrams as graphics 161
  saving diagrams as HTML documents 161
  saving projects in other file formats 159
Go to Pictures tool 112
Go to Writing tool 47, 104
graphic file formats 159
graphics
  copying and pasting into symbol libraries 150
  dragging and dropping into symbol libraries 148
  inserting into diagrams 103
  inserting into symbol libraries 148

H
hardware and software requirements 6
hiding
  desktop 145
  lined paper 52, 121
  symbol captions 33, 77
  symbols in Writing View 79
HTM files
  saving diagrams as graphics 161
  saving diagrams as HTML documents 161
HTML documents
  saving diagrams as 161
  saving documents in other file formats 159
  saving writing projects as 162
hyperlinks
  adding 67, 140
  adding to selected text 141
  automatic formatting 146
  deleting 141
  turning on or off 146

I
ideas
adding 48, 107
adding details 51, 107
changing level 49, 108
changing order 50, 108
copying and pasting 110
cutting and pasting 111
locking position 109
moving left or right 108
moving up or down 108
removing 110
selecting 109
selecting all 110
selecting multiple 110
sorting 96
importing files 156
inserting
graphics into diagrams 103
graphics into symbol libraries 148
Inspiration documents 157
Inspiration Software
customer service 11
installing
Adobe Reader 12
Kidspiration 8
Internet hyperlinks
adding 67, 140
adding to selected text 141
automatic formatting 146
deleting 141
turning off 146
italic formatting 114
J
JPEG files
inserting into diagram 103
saving projects in other file formats 159
K
keyboard shortcuts 165
Kidspiration
documentation 12
installing 8
new features 2
registering 10
L
landscape page orientation 133
Lasso tool 91
license agreement 171
Line tool 86
line width
    links 118
    SuperGrouper shapes 115
    symbols 115
lined paper
    colors 120
    showing or hiding 52, 121
lines
drawing using Symbol Maker tool 85
Link Symbols tool 93
links
    adding 42, 93
    adding text 95
    arrowhead style 118
    color 119
dashed 118
    line width 118
    Link Symbols tool 42
    moving 94
    moving text 96
    removing 102
    reversing 95
Listen tool 70
turning on or off 144
using 70, 128
listening to text 70, 128
locking
    ideas 109
    symbols 69, 80
M
magnifying the view 104
Microsoft Word 55
modifying activities 139
Move Left tool 108
Move Right tool 49, 108
moving between symbol libraries 21
moving ideas
    left or right 108
    up or down 108
moving links 94
moving selections in Symbol Maker
drawing 91
moving symbols
    by dragging 79
    within libraries 152
N
name
  adding 30
  adding to project 17
  printing at top of page 132
navigating
  Picture View 167
  Writing View 167
new features 2
notes
  adding to ideas 51, 107

O
opening
  activities 66, 136
  documents 17, 46
  documents created in other programs 156
  Inspiration documents 157
  Kidspiration 1 documents 156
options
  animated symbols 144
  desktop 145
  Listen tool 144
  preferred word processor 147
  sound recording 144
  spelling checker 145
  talking interface 143
  Teacher menu password 147
  URL hyperlink auto-detection 146
  URL hyperlinks 146
order of ideas 50
order of symbols in libraries 152

P
page numbers
  printing 131
  page orientation 133
Paint Bucket tool 36, 91
Paintbrush tool 36, 85
paper size 132
password
  disabling 147
  enabling 147
  setting 67, 135
PICT files
  inserting into diagram 103
  saving projects in other file formats 159
Picture View
Formatting toolbar 23
  navigating 167
  overview 18
  Picture toolbar 20
  switching to 112
picture-to-topic option
  using to begin writing 105
playing recorded sounds 72, 130
portrait page orientation 133
preferred word processor
  publishing document 157
  selecting 147
prefix style 54, 120
printing documents 72, 131
printing Kidspiration documentation 12
printing options
  name 132
  page numbers 131
  page orientation 133
  paper size 132
Publish tool 55, 157
publishing documents in word processor 55, 157
publish options 158

R
reading text
  Listen tool 128
  program buttons and menus 128
  turning talking interface on or off 143
recording
  recording sounds 71, 128
  turning sound recording on or off 144
  using audio in a project 127
reducing the view 104
registering Kidspiration 10
removing
  hyperlinks 141
  ideas 110
  Kidspiration 13
  links 102
  part of diagram 43
  symbols 101
  symbols and links 102
renaming a project 18
reversing a link 95
reverting to original symbol colors 116
saving documents 30, 54, 58
as activities 73
Kidspiration format 160
new name 18
other file formats 159
Save command 18
Select tool 91
selecting
all ideas in outline 110
all objects on diagram 101
area using Symbol Maker tools 91
ideas 109
multiple ideas 110
multiple symbols 100
part of diagram 101
preferred word processor 147
symbols 100
symbols and links 100
words 124
selecting and moving ideas
shortcuts 169
setting
password 135
publish options 158
shapes
drawing using Symbol Maker tools 87
sharing
activities 140
default look with other computers 143
symbol libraries 155
shortcuts
adding ideas in Writing View 169
adding links 169
adding symbols 168
audio features 170
changing the view 166
editing text 170
formatting text 170
moving between symbol libraries 167
navigating in Picture View 167
navigating in Writing View 167
selecting and moving ideas 169
selecting and moving symbols 169
selecting text 170
showing
desktop 145
lined paper 121
symbol captions 77
size
SuperGrouper categories 117
symbols 117
software and hardware requirements 6
Solid Square tool 89
sorting ideas 96
sounds
erasing 130
playing 130
recording 129
spacing symbols evenly 81
spelling checker
editing user dictionary 125
turning on or off 145
using 124
Spray Can tool 37, 86
Square tool 88
Stamp tool 38, 89
starting
diagrams 29, 57
Kidspiration 15, 28
new documents 15
writing projects 105
student name
adding to document 17
printing at top of page 132
SuperGrouper categories
adding symbols 63, 98
adding titles 61, 98
adding to diagram 58, 97
colors 61, 116
creating 59, 98
line width 115
removing symbols 99
resizing 117
Venn diagram 98
SuperGrouper tool 97
support 11
switching
to Picture View 112
to Writing View 47, 63, 104
symbol captions
picture-to-topic 105, 106
showing or hiding 33, 77
symbol categories 153
Symbol Guide 12
symbol libraries
copying 154
copying and pasting graphics 150
creating 154
customizing 147
inserting graphics files 149
inserting graphics from diagrams 148
rearranging symbols 152
removing symbols 151
sharing 155
Symbol Maker tool 34–39
Circle tool 87
Clear All tool 35, 93
clearing part of drawing 91
copying and pasting selection 91
drawing lines 85
drawing shapes 87
drawing symbols 82
Eraser tool 36, 92
filling area with color 91
Lasso tool 91
Line tool 86
moving selection 91
Paint Bucket tool 36
Paintbrush tool 36, 85
Select tool 91
selecting area 91
Solid Circle tool 88
Solid Square tool 89
Spray Can tool 37, 86
Square tool 88
Stamp tool 38, 89
tools 84
Undo tool 35
Symbol palette 21, 32
symbol shapes 77
symbols
adding 32, 76
adding text 78
adding to symbol libraries 148
aligning 81
color 116
connecting 42, 93
copying and pasting 103
cutting and pasting 102
drawing using Symbol Maker tool 34–39, 82
drawing symbols 82
editing text 123
formatting 115
line width 115
locking position 69, 80
removing 101
removing links 102
selecting 100
shape 77
showing only in Picture View 79
size 117
sorting 96
spacing evenly 81
system requirements 6

t
Teacher menu
enabling 67
enabling or disabling password 147
password 67
Teacher symbol 79, 80
creating 69
Technical Support 11
text
adding to ideas 107
adding to links 95
adding to symbols 78
bold formatting 114
color 114
copying and pasting 124
cutting and pasting 124
ingoing ideas 123
editing symbols 123
font 113
formatting 43–44, 113
italic formatting 114
moving on a link 96
size 113
underlining 114
Text Color tool 44
text files
saving writing projects as 163
text size 113
titles
SuperGrouper categories 61, 98
toolbars
Formatting toolbar in Picture View 22
Formatting toolbar in Writing View 26
Picture toolbar 20
Writing toolbar 25
transferring documents to word processor 55, 157
Publish tool 157
turning on or off
animated symbols 144
Listen tool 144
sound recording 144
spelling checker 145
talking interface 143
Teacher menu password 147
URL hyperlink auto-detection 146
URL hyperlinks 146
type size 113

U
underlining text 114
Undo tool 43, 103, 111
Symbol Maker 35, 85
URL hyperlink auto-detection 146
URL hyperlinks
  adding 140
  adding to selected text 141
  automatic formatting 146
  deleting 141
  turning on or off 146
User’s Guide 12

V
Venn diagram 98
view
  fitting diagram in window 104
  magnifying or reducing 104
voice
  choosing 127
  turning talking interface on or off 143

W
Web pages
  saving diagram as 161
  saving writing project as 162
WMF files
  inserting into diagram 103
word processor
  publishing documents 55, 157
  selecting preferred 147
words
  selecting 124
writing projects
  publishing in word processor 157
  saving 18
  saving as HTML documents 162
  saving as text files 163
  starting 105
  using ideas from diagram 105

X
X in Symbol Colors tool 116
Standard  Students use descriptive language to clarify and enhance ideas.

1. Use pictures and words to describe a topic.
2. Go to Writing View to add details.

My Topic

Challenge! Try to use all five senses in your description.
**Standard** Students use a variety of strategies, such as drawing pictures, to describe experiences, people, objects, events, places and story elements.

1. Use pictures and words to tell about yourself.
2. Go to Writing View and add a sentence for each idea.
**Standard**  Students understand character development and characterization techniques in literary works.

1. Use pictures and words to tell about a character in your book.
2. Go to Writing View to add details.
**Standard**  Students produce journals and response logs.

- **Tell what you are thinking in each of these areas today.**
- **Today’s date is:**
- **weather**
- **reading**
- **home**
- **school**
- **friends**
**Standard**  Students develop skills, such as organization and conventions of form, to write personal and formal letters.

- Write today's date below the line.
- Who are you writing to?
  Dear
  
  Paragraph 1: Tell what you have been doing. Write your sentences below the line

  Paragraph 2: Ask what your friend has been doing

  Paragraph 3: Add something interesting -- maybe some news or a funny story.

  End your letter. "Sincerely," or "Your friend," or "Love."

  *Don't forget to add your name!*
Parts of Speech

**Standard** Students use proper conventions of grammar and usage in written work.

1. Write vocabulary words in the boxes.

2. Put each word into the correct category.

3. Go to Writing View and write a sentence for five of the words.
**Standard**  Students use evidence to support opinions, respond to others’ ideas and elaborate on issues.

1. Use pictures and words to share your ideas about an issue.
2. Go to Writing View to start a persuasive essay that supports your opinion.

---

**Subject**

**My opinions**

**The other side's opinions**

**My response**

**My response**

**My response**
**Standard** Students understand the similarities and differences between real life and life depicted in visual media, such as cartoons and movies.
Snake with an Ss

**Standard**  Students use basic elements of phonetic analysis to decode unknown words.

Find pictures that start with **Ss**.

Find pictures that start with **Ll**.

Find pictures that start with **Mm**.

Challenge! Go to Writing View and use your imagination to write sentences that make a connection between the animals and the pictures you chose.
**Standard**  Students use simple narrative strategies to write autobiographical compositions.
**Standard**  Students understand the concepts of sequence, setting, characters, main events and plot in stories.

1. Use pictures and words to tell about your story.
2. Go to Writing View to add details.

- **What is the writer trying to say?**
- **Who are the characters?**
- **What happens in the story?**
- **Where does the story take place?**

**Title and Author**

©2004 Inspiration Software, Inc.
**Tell a Story**

**Standard** Students write stories and personal experience narratives.

1. **Share your ideas for stories**

   - **Think of some characters.**
   - **Think of some settings.**
   - **Think of some actions.**

2. **Go to Writing View to add details.**

Now choose the characters, setting and actions for a story you will write.
Thinking about Poetry

**Standard**  Students read and respond to a wide variety of stories, poems and other literature.

.Title and author of poem? Write your thoughts in the notes area of each idea.

? What is the poem about?

? What did the poem make you think of?

? What words did you like?

? How did the poem make you feel?
**Standard**  Students use past, present and future verb tenses in written work.
**Vocabulary Word**

**Standard** Students develop strategies to acquire vocabulary.

- **Tell what this word means:**
- **Add a new word to your vocabulary:**
- **Add a word or picture clue to help you remember:**
- **Use this word in a sentence:**
- **New Word**
A Time in the Past

**Standard**  Students understand how cultures change over time.

1. Use pictures and words to tell about a time in the past.
2. Go to Writing View and write a sentence about each idea.
Citizenship

**Standard** Students understand the requirements of good citizenship.

Everyone wants to sail on the citizen-ship!

To earn your ticket, use pictures and words to tell how to be a good citizen.

In the environment

At home

At school

With people

At school

With people
**Community Comparison**

**Standard**  Students describe and classify the physical and human characteristics of urban, rural and suburban communities.

Use pictures and words to show what life is like in urban and rural areas.

- **urban only**
- **urban and rural**
- **rural only**

Challenge! Go to Writing View and describe how suburban life compares to both urban and rural life.
Community Services

**Standard**  Students understand the roles of people who serve their community.

---

**Community Services**
What are these community services for? Write or record your ideas for each one.

- **hospital**
- **police station**
- **fire department**
- **school**

---
Culture Comparison

**Standard**  Students understand the similarities and differences within and among cultures in different societies.

Use pictures and words to compare two cultures.
**Effect of Event**

**Standard** Students understand the concept of cause and effect.

1. Use pictures and words to describe how an event affects the world around us.
2. Go to Writing View to add details.
Goods and Services

**Standard** Students recognize ways in which basic needs and wants are met through the production of goods and services.

Use pictures and words to tell about goods and services. People earn their livings by providing goods and services for sale or trade. How many can you think of?

**Goods are:**

**Services are:**
**Historical Event**

**Standard**  Students summarize the key events of the era they are studying and explain the historical contexts of those events.
Holidays

Standard Students recognize and understand the people and events honored in commemorative holidays and celebrations.

Holidays are special occasions that commemorate certain people or events.

1. Use pictures and words to tell about a holiday.

2. Go to Writing View to add details and explain the significance of the holiday.
**Standard** Students construct maps and models of neighborhoods, incorporating such structures as police and fire stations, airports, banks, hospitals, supermarkets, harbors, schools, homes and transportation lines.

Use pictures and words to tell about your neighborhood.
Now and Long Ago

**Standard** Students understand how cultures change over time.

Use pictures and words to show how life today is different from the way it was long ago.

Go to Writing View to add details.
Standard  Students identify and follow classroom and school rules that guide behavior and establish order to accomplish tasks.

Use pictures and words to tell about rules.
Signs

Standard  Students use strategies to understand informational texts, such as charts, graphs, signs and warnings.

1. Read or listen to the clues below.
2. Click the clues one at a time, then click the sign that goes with it.

Poison  Hospital  Information
Walk  Stop  Wheelchair Access
Recycle  Don't Walk  Restroom

3. Think of one of your classroom rules. Find or create a sign to describe this rule.
**Standard**  Students understand the physical and human characteristics of their state or region.
Standard  Students understand the difference between needs and wants.

Use pictures and words to tell about different wants and needs.

<table>
<thead>
<tr>
<th>Wants</th>
<th>Needs</th>
</tr>
</thead>
<tbody>
<tr>
<td>For lunch</td>
<td></td>
</tr>
<tr>
<td>On a cold day</td>
<td></td>
</tr>
<tr>
<td>A place to live</td>
<td></td>
</tr>
</tbody>
</table>

For lunch

Go to Writing View to add details.
**Animal Classification**

**Standard** Students know that living things can be sorted into groups using various features.

- **insect**
  - beetle

- **bird**
  - pigeon

- **mammal**
  - kitten

- **reptile**
  - snake

Use pictures and words to add more animals to each category.
**Standard**  Students know that plants and animals have features that help them live in different environments.

Use pictures and words to tell about your animal.
Standard  Students understand eating a variety of healthy foods helps people to stay healthy.

1. Drag foods into the correct food groups.
2. Plan a balanced meal by moving foods onto the lunch tray.
**Standard**  Students know that both slow and rapid processes, such as erosion, landslides and earthquakes, are constantly changing features on the Earth’s surface.

Use pictures and words to describe the causes and effects of a natural event like a volcano or earthquake.
**Standard** Students develop an understanding of objects in the sky and the way they change.

Clouds

- **Stratus Clouds**
  - What do they look like?
  - What type of weather do they predict?

- **Cirrus Clouds**
  - What do they look like?
  - What type of weather do they predict?

- **Cumulus Clouds**
  - What do they look like?
  - What type of weather do they predict?

1. Use pictures and words to tell about clouds.
2. Go to Writing View to add details.
**Standard**  Students design and implement simple investigations and communicate findings to others.

---

**Science Experiment**

---

**What do I want to find out?**

---

**Hypothesis**

---

**What steps will I take?**

1. 

2. 

3. 

---

**What are the results?**

1. 

---
**Standard**  Students observe common objects using the five senses.

Use pictures and words to describe a scene.

My Scene

I would see

I would smell

I would hear

I would taste

I would touch
**Standard**  Students understand that plants are the source of all animals’ food in most ecosystems.

1. Use pictures and words to tell about animals and plants.
2. Use the Link tool to show the feeding relationships between the animals and plants.
**Standard**  Students know that plants and animals have features that help them live in different environments.

1. Use pictures and words to describe the plants and animals that live in each habitat.
2. Go to Writing View to add details.
**Measurement Tools**

**Standard** Students use appropriate tools and simple equipment to gather scientific data and extend the senses.

1. Use pictures and words to tell about the property that each tool measures.

2. Give an example of something you could measure with each tool.
**Standard**  Students design and implement simple scientific investigations.

---

**Recording Observations**

**Directions:**

1. Choose a natural system to study, such as a local habitat, celestial objects or the seasons.
2. At regular intervals, observe changes in the system.
3. Take notes on what you observe, and include the date and time in your notes.

<table>
<thead>
<tr>
<th>Date and Time:</th>
<th>Notes:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

<table>
<thead>
<tr>
<th>Date and Time:</th>
<th>Notes:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

<table>
<thead>
<tr>
<th>Date and Time:</th>
<th>Notes:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Students know that changes in weather occur from day to day and over seasons, affecting the Earth and its inhabitants.

Winter

Fall

Spring

Summer

Use pictures and words to describe how seasons are different.
**Simple Cycles**

**Standard** Students know that the basic life cycle of living things consists of birth, growth and development, reproduction and death.

Use pictures and words to create a simple cycle.

Ideas: plants, frog, water, butterfly
Standard  Students know that forces cause changes in speed or direction in the motion of objects.

1. Use pictures and words to tell about each kind of simple machine.

2. Go to Writing View to add details.
This Week’s Weather

**Standard** Students understand that short-term weather conditions can change daily.

Use pictures and words to show the kind of weather your town has each day of the week.
Math
Alike and Different

**Standard** Students identify common geometric figures and classify them by common attributes.

1. Put the pictures that don't belong into the empty boxes.
2. Add two new pictures that go with the one you dragged out.
3. Go to Writing View to explain why the pictures belong together.
Alternative Solutions

**Standard**  Students understand various meanings of multiplication and division.

Think of different ways to solve the problem.

Solve $6 \times 27$

- First way

  $3(2 \times 9)$

- Second way
Use the square blocks below to build rectangles that contain from 1 to 9 blocks. Enter the number of squares in the length and width of each rectangle you create.

<table>
<thead>
<tr>
<th>Number of squares</th>
<th>Rectangle dimensions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>L=1 W=1</td>
</tr>
<tr>
<td>2</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
</tr>
</tbody>
</table>

Questions

- Which numbers of squares make rectangles with sides of equal length?
- Which rectangles are only one square wide?
- If you had 13 squares, how many possible rectangles could you make?
- What is the next number of squares that would make a rectangle with equal sides?
**Caterpillar Subtraction**

**Standard** Students compute fluently and make reasonable estimates.

1. There are 7 left on the Full Leaf.
   - $10 - ? = 7$

2. There are 6 left on the Full Leaf.
   - $10 - ? = 6$

3. There are an equal number on both leaves.
   - $10 - ? = ?$

Move caterpillars from the full leaves to the empty leaves so that:
**Estimation**

**Standard** Students use a variety of methods and tools, such as objects, mental computation and estimation, to compute.

How many apples will fit inside the Medium Cart?

My guess

How many apples will fit inside the Medium Cart?

How many apples will fit inside the Big Cart?

How many apples will fit inside the Little Cart?
Factor Maker

**Standard** Students identify such properties as commutativity, associativity and distributivity and use them to compute with whole numbers.

Use the Symbol Maker to make factor patterns for the numbers below.

### Four
- $2 \times 2$

### Six

### Eight

### Ten
- $2 \times 5$
- $5 \times 2$

### Twelve

### Sixteen
- $2 \times 8$
- $8 \times 2$
- $4 \times 4$
**Fraction Action**

**Standard**  Students recognize and generate equivalent forms of commonly used fractions, decimals and percents.

Move the fractions to the correct category.

\[
\begin{align*}
\frac{7}{21} & \quad \frac{8}{32} & \quad \frac{3}{6} & \quad \frac{4}{16} & \quad \frac{2}{6} \\
\frac{3}{12} & \quad \frac{2}{8} & \quad \frac{3}{9} & \quad \frac{2}{4} & \\
\end{align*}
\]

- one half
- one third
- one fourth
**Standard**  Students understand numbers, ways of representing numbers, relationships among numbers and number systems.

One Quarter

```
0  1/4  2/4  3/4  1
0  .25  .50  .75  1
```

Study the pattern on the number line above. Use the Symbol Maker to make a similar pattern on the number line below.

One Fifth

```
0  1/5  1
0  1
```

Study the pattern on the number line above. Use the Symbol Maker to make a similar pattern on the number line below.
Making Change

**Standard** Students model and solve problems by representing, adding and subtracting amounts of money.

**Buying an Ice Cream Sundae**

Cost = $3.45

First way:  
Second way:  
Third way:

- penny = 1¢  
- nickel = 5¢  
- dime = 10¢  
- quarter = 25¢  
- one dollar = 100¢

Imagine you have $5.00. Think of three different ways you could get change.

**Remember:**

- penny = 1¢  
- nickel = 5¢  
- dime = 10¢  
- quarter = 25¢  
- one dollar = 100¢
Making Sets

**Standard** Students develop understanding of the relative position and magnitude of whole numbers and of ordinal and cardinal numbers and their connections.

- Count how many numbers are in Set 1.
- Put the same number of baby animals in Set 2.
- Put two less pumpkins in Set 3.
- Make Set 4 have the same number of birds as Set 1. Make the fourth bird a swan.

Set One

1 2 3 4 5 6 7

Set Two

Set Three

Set Four
Standard  Students represent and analyze mathematical situations and structures using algebraic symbols.

- \( \square - 6 = 7 \)  
  A number minus 6 equals 7

- \( 4 \times \square = 16 \)  
  4 times a number equals 16

- \( \square \div 4 = 8 \)  
  A number divided by 4 equals 8

Record the thinking steps you use to find the missing numbers in each problem. Type the missing numbers into the correct symbols.
**Patterns**

**Standard** Students recognize, describe and extend patterns such as sequences of sounds and shapes.

Add pictures to complete each pattern.

Now make your own pattern!
Rectangles and Triangles

**Standard**  Students recognize, name, build, draw, compare and sort two-and three-dimensional shapes.

Use pictures and words to identify objects that are made of rectangles and triangles.
**Standard** Students recognize, name, build, draw, compare and sort two-and three-dimensional shapes.

1. Write or record the name for each shape.

2. Drag pictures that use these shapes into the empty box.
**Standard**  Students develop a sense of whole numbers and represent and use them in flexible ways, including relating, composing and decomposing numbers.

1. Tell how many blocks are in each example.
2. Figure out a different way to put 37 blocks into the empty box.
More
**Standard**  Students recognize structural patterns or organization, such as cause and effect, in informational texts.

**Use pictures and words to tell about cause and effect.**
Chain of Events

**Standard** Students retell the order of important events.

Use pictures and words to tell about the stages of an event.
Classifying Ideas

Standard  Students interpret and evaluate information and ideas.

1. Name each of the three categories.
2. Type thoughts, ideas or facts into the rectangles.
3. Sort your ideas.

---

©2004 Inspiration Software, Inc.
Comparison

**Standard**  Students develop mental processes based on identifying similarities and differences.

Use pictures and words to tell how two things or ideas are alike and different.
**Standard**  Students use structural patterns or organization to understand informational texts.

Use pictures and words to explain an idea.  Type words on the links to show the relationships between details.
**Fact or Opinion**

**Standard**  Students understand the difference between fact and opinion.

1. Use pictures and words to represent different things or ideas.
2. Write a fact and an opinion for each of your choices.

Fact: Over 42 games available.

Opinion: The best games ever!

Fact:

Opinion:

Your Choice

Fact:

Opinion:

Fact:

Opinion:
**Five Facts**

**Standard** Students collect information for research purposes.

Use pictures and words to tell five facts about a topic.
**Standard** Students make and defend decisions about daily activities.

---

**Get Ready!**

Use pictures to dress each child for their special occasion.

Leo is going camping.  
Jane is going to a fancy party.  
Mike needs a silly costume for a play.  
Monica is going to the beach.  
Think of your own special occasion.
**Standard**  Students develop a variety of strategies, such as organizing information, planning a course of action and determining how to locate information, to plan research.

*Use pictures and words to tell about a topic.*

![Diagram](image)

- **K** (What I already know)
- **W** (What I need to find out)
- **L** (What I learned)
Responding to Questions

**Standard** Students ask and answer how, when, where and why questions about elements of a text.
Supporting Details

**Standard**  Students convey understanding of the main idea and supporting details in a reading selection.

Use pictures and words to describe an idea and add details
Enter your observations and work your way around the wheel to refine your question.

- What I observed
- What was interesting
- Some questions I have
- The ones I think I can answer
- My question

**Standard** Students develop strategies to understand informational texts.
**Venn Diagram**

**Standard**  Students develop mental processes based on identifying similarities and differences.

Use pictures and words to show the similarities and differences between two things or ideas.

![Venn Diagram](image)

Thing or Idea A

Thing or Idea B
**Standard** Students develop prewriting strategies, such as using graphic organizers, story maps and webs, to plan written work.

Use pictures and words to describe a thing or idea.
Writing Directions

Standard  Students give precise directions and instructions such as in games and tasks.

Use pictures and words to give directions for a task or game.

How to:

1
2
3
4
5
6
7
8
Animals & Plants

Baby Animals

- wolf pup
- lion cub
- puppy
- kitten
- lamb
- calf
- duckling
- swan
- lizard
- hedgehog
- piglet
- tiger cub
- swan
- duck
- bunnies
- chick
- eggs in nest
- seal pup
- bear cub
- fawn

Animals & Plants

Birds

- bird
- robin
- pigeon
- hummingbird
- parrot
- toucan
- owl
- eagle
- hawk
- vulture
- rhino
- alligator
- panda
- bear
- penguin
- blue heron
- turkey
- peacock
- ostrich
- flamingo
- kangaroo
- koala
- monkey
- gorilla
- camel
- giraffe

Animals & Plants

Wild Animals

- lion
- tiger
- cougar
- wolf
- zebra
- buffalo
- hippo
- elephant
- rhino
- alligator
- panda
- bear
- kangaroo
- koala
- monkey
- gorilla
- camel
- giraffe

* animated symbol
<table>
<thead>
<tr>
<th>Animals &amp; Plants</th>
<th>Animals &amp; Plants</th>
<th>Animals &amp; Plants</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bugs and Reptiles</td>
<td>Ocean Life 1</td>
<td>Ocean Life 2</td>
</tr>
<tr>
<td>fly</td>
<td>starfish</td>
<td>oyster</td>
</tr>
<tr>
<td>bee</td>
<td>clam</td>
<td>shell</td>
</tr>
<tr>
<td>butterfly</td>
<td>conch</td>
<td>coral</td>
</tr>
<tr>
<td>praying mantis</td>
<td>sand dollar</td>
<td>sponge</td>
</tr>
<tr>
<td>moth</td>
<td>fish</td>
<td>fish</td>
</tr>
<tr>
<td>dragonfly</td>
<td>seahorse</td>
<td></td>
</tr>
<tr>
<td>ladybug</td>
<td>walrus</td>
<td>seal</td>
</tr>
<tr>
<td>snail</td>
<td></td>
<td></td>
</tr>
<tr>
<td>spider</td>
<td>dolphin</td>
<td>fish</td>
</tr>
<tr>
<td>ladybug</td>
<td></td>
<td></td>
</tr>
<tr>
<td>snail</td>
<td></td>
<td></td>
</tr>
<tr>
<td>scorpion</td>
<td>octopus</td>
<td></td>
</tr>
<tr>
<td>lizard</td>
<td>jellyfish</td>
<td></td>
</tr>
<tr>
<td>beetle</td>
<td>stingray</td>
<td></td>
</tr>
<tr>
<td>cricket</td>
<td>shark</td>
<td></td>
</tr>
<tr>
<td>tadpole</td>
<td></td>
<td></td>
</tr>
<tr>
<td>frog</td>
<td></td>
<td></td>
</tr>
<tr>
<td>crab</td>
<td></td>
<td></td>
</tr>
<tr>
<td>lobster</td>
<td></td>
<td></td>
</tr>
<tr>
<td>chrysalis</td>
<td>pufferfish</td>
<td></td>
</tr>
<tr>
<td>caterpillar</td>
<td>turtle</td>
<td>algaes</td>
</tr>
</tbody>
</table>

* animated symbol
Animals & Plants

Dinosaurs
- Gigantosaurus
- Pterodactyl
- Allosaurus
- Parasaurolophus
- Tyrannosaurus
- Argentinosaurus
- Triceratops
- Stegosaurus
- Velociraptor
- Dimetrodon
- Styracosaurus
- Ankylosaurus
- Cryptoclidus
- Mammoth
- Thylacine
- Sabertooth Tiger
- Hesperonis
- Dodo

Plants
- flower
- flowers
- rose *
- flowers
- holly
- flower
- rose
- flower
- cactus
- cactus
- wheat
- acorn
- plant
- fern
- seedling
- dandelion *

Trees
- tree
- tree
- tree
- tree
- palm tree
- tree
- cactus
- sapling
- tree stump
- pine cones
- leaves
- leaves

* animated symbol
<table>
<thead>
<tr>
<th>Fun Stuff</th>
<th>Fun Toys</th>
<th>Geography Habitats</th>
</tr>
</thead>
<tbody>
<tr>
<td>clock</td>
<td>marbles</td>
<td>mountains</td>
</tr>
<tr>
<td>rubber ducky</td>
<td>dice</td>
<td>hills</td>
</tr>
<tr>
<td>suitcase</td>
<td>cards</td>
<td>river</td>
</tr>
<tr>
<td>piggy bank</td>
<td>checkers</td>
<td>canyon</td>
</tr>
<tr>
<td>lantern</td>
<td>game</td>
<td>underwater</td>
</tr>
<tr>
<td>glasses</td>
<td>chess</td>
<td>rainforest</td>
</tr>
<tr>
<td>rocking horse</td>
<td>sled</td>
<td>forest</td>
</tr>
<tr>
<td>banana peel</td>
<td>blocks</td>
<td>glacier</td>
</tr>
<tr>
<td>calendar</td>
<td>train</td>
<td>tundra</td>
</tr>
<tr>
<td>magic rabbit</td>
<td>top</td>
<td>wetlands</td>
</tr>
<tr>
<td>mask</td>
<td>doll</td>
<td>peninsula</td>
</tr>
<tr>
<td>Lava Lamp</td>
<td>jump rope</td>
<td>desert</td>
</tr>
<tr>
<td>bubbles</td>
<td>newspaper</td>
<td>island</td>
</tr>
<tr>
<td>robot</td>
<td>robot</td>
<td>valley</td>
</tr>
<tr>
<td>monster</td>
<td>teddy bear</td>
<td>plateau</td>
</tr>
<tr>
<td>teeth</td>
<td>monkey</td>
<td>plains</td>
</tr>
<tr>
<td>pot of gold</td>
<td>wagon</td>
<td>bay</td>
</tr>
<tr>
<td>merry-go-round</td>
<td>space ship</td>
<td>beach</td>
</tr>
<tr>
<td>pinwheel</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* animated symbol
### Language Arts Stories
- cauldron
- magic tree
- magic wand
- carriage
- cottage
- rainbow
- castle
- tower
- bat
- ghost
- flying carpet *
- magic lamp
- snake *
- spinning wheel
- magic mirror
- crystal ball
- glass slipper
- man in the moon *

### Math Tools
- \( + \) add
- \( - \) subtract
- \( \times \) multiply
- \( \div \) divide
- \( = \) equal
- \( \sqrt{\,} \) divide
- \( > \) greater than
- \( < \) less than
- \( \frac{1}{2} \) half
- \( \frac{1}{3} \) thirds
- \( \frac{1}{4} \) fourths
- \( \frac{1}{6} \) sixths
- \( \frac{1}{8} \) eighths

### Math Shapes
- circle
- oval
- triangle
- square
- rectangle
- parallelogram
- trapezoid
- pentagon
- hexagon
- octagon
- triangle
- triangle
- triangle
- triangle
- sphere
- cube
- pyramid
- cylinder

* animated symbol
<table>
<thead>
<tr>
<th>Numbers &amp; Letters</th>
<th>Numbers &amp; Letters</th>
<th>Numbers &amp; Letters</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Numbers 1</strong></td>
<td><strong>Numbers 2</strong></td>
<td><strong>Letters A-H</strong></td>
</tr>
<tr>
<td>1 2</td>
<td>1 one</td>
<td>abc abc</td>
</tr>
<tr>
<td>3 4</td>
<td>2 two</td>
<td>A a</td>
</tr>
<tr>
<td>5 6</td>
<td>3 three</td>
<td>B b</td>
</tr>
<tr>
<td>7 8</td>
<td>4 four</td>
<td>C c</td>
</tr>
<tr>
<td>9 10</td>
<td>5 five</td>
<td>D d</td>
</tr>
<tr>
<td>0 1/2</td>
<td>6 six</td>
<td>E e</td>
</tr>
<tr>
<td>1/3 1/4</td>
<td>7 seven</td>
<td>F f</td>
</tr>
<tr>
<td>100 1000</td>
<td>8 eight</td>
<td>G g</td>
</tr>
<tr>
<td>⌀ $</td>
<td>9 nine</td>
<td>H h</td>
</tr>
</tbody>
</table>

* animated symbol
<table>
<thead>
<tr>
<th>Numbers &amp; Letters</th>
<th>Numbers &amp; Letters</th>
<th>Numbers &amp; Letters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Letters I-Q</td>
<td>Letters R-Z</td>
<td>Punctuation</td>
</tr>
<tr>
<td>Ii</td>
<td>Rr</td>
<td>!</td>
</tr>
<tr>
<td>Jj</td>
<td>Ss</td>
<td>i</td>
</tr>
<tr>
<td>Kk</td>
<td>Tt</td>
<td>reverse exclamation point</td>
</tr>
<tr>
<td>Ll</td>
<td>Uu</td>
<td>?</td>
</tr>
<tr>
<td>Mm</td>
<td>Vv</td>
<td>?</td>
</tr>
<tr>
<td>Nn</td>
<td>Ww</td>
<td>reverse question mark</td>
</tr>
<tr>
<td>Oo</td>
<td>Xx</td>
<td>;</td>
</tr>
<tr>
<td>Pp</td>
<td>Yy</td>
<td>:</td>
</tr>
<tr>
<td>Qq</td>
<td>Zz</td>
<td>semicolon colon</td>
</tr>
<tr>
<td></td>
<td></td>
<td>left quotation mark right quotation mark</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ellipsis asterisk</td>
</tr>
<tr>
<td></td>
<td></td>
<td>left parenthesis right parenthesis</td>
</tr>
<tr>
<td></td>
<td></td>
<td>at &amp;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>é ñ</td>
</tr>
</tbody>
</table>

* animated symbol
<table>
<thead>
<tr>
<th>Social Studies</th>
<th>Social Studies</th>
<th>Social Studies</th>
</tr>
</thead>
<tbody>
<tr>
<td>US History</td>
<td>Cultures</td>
<td>Landmarks</td>
</tr>
<tr>
<td>George Washington</td>
<td>Venice</td>
<td>Easter Island</td>
</tr>
<tr>
<td>Martin Luther King, Jr.</td>
<td>church</td>
<td>Gateway Arch</td>
</tr>
<tr>
<td>Sacagawea</td>
<td>Stonehenge</td>
<td>Machu Picchu</td>
</tr>
<tr>
<td>Harriet Tubman</td>
<td>temple</td>
<td>St. Basil's Cathedral</td>
</tr>
<tr>
<td>Eleanor Roosevelt</td>
<td>Nepal</td>
<td>Parthenon</td>
</tr>
<tr>
<td>Abraham Lincoln</td>
<td>fishermen</td>
<td>Arc de Triomphe</td>
</tr>
<tr>
<td>Benjamin Franklin</td>
<td>desert</td>
<td>Golden Gate</td>
</tr>
<tr>
<td>women's rights</td>
<td>Buddha</td>
<td>Forbidden City</td>
</tr>
<tr>
<td>Alamo</td>
<td>farmer</td>
<td>Great Wall</td>
</tr>
<tr>
<td>liberty bell</td>
<td>mosque</td>
<td>Statue of Liberty</td>
</tr>
<tr>
<td>United States of America</td>
<td>United States of America</td>
<td></td>
</tr>
<tr>
<td>Betsy Ross flag</td>
<td>Royal Canadian Guard</td>
<td>United States of America</td>
</tr>
<tr>
<td>explorer ship</td>
<td>Chichen Itza</td>
<td>Colosseum</td>
</tr>
<tr>
<td>Paul Revere*</td>
<td>cliff dwelling</td>
<td>Sydney Opera House</td>
</tr>
<tr>
<td>covered wagon</td>
<td>US Capitol</td>
<td>Pyramids</td>
</tr>
<tr>
<td>Native American</td>
<td>Thames</td>
<td>Taj Mahal</td>
</tr>
<tr>
<td>homestead</td>
<td>monks</td>
<td>Big Ben</td>
</tr>
<tr>
<td>Civil War</td>
<td>Vietnam</td>
<td>Sphinx</td>
</tr>
</tbody>
</table>

* animated symbol